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WELCOME TO THE M300
This book contains an introduction to the M300 system and documentation
including a product overview, major features, system requirements and contact
information.

OPERATING INSTRUCTIONS

This book contains instructions on how to operate the M300.

WINDOW DISPLAYS

This book contains detailed information about the format/layout and operation
of the various M300 display windows.

GETTING STARTED

This book contains instructions on how to quickly begin using QNX and the
M300.

MAIN WINDOW AND PROPERTIES

This book contains information on the M300 main interface window.

PROJECT MANAGEMENT

This book contains instructions on working with projects on the M300.

GENERAL INFORMATION

This book contains general information and notes on various features and
operations of the M300.

SETUP

This book contains detailed setup instructions for board, acquisition and buffers.

SERVICE AND TROUBLESHOOTING

This book contains information on general troubleshooting, disaster recovery
procedures for the M300 system and service required.

Please E-mail your comments on the documentation to docs@scieng.com.

mailto:docs@scieng.com
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WELCOME TO THE M300

The M300 is a Data Acquisition System based on the QNX 4 OS (real-time, UNIX like, POSIX
certified) from QSSL using Photon 1.14 as the GUI. It runs on Pentium based systems with a
minimum of 128 MB RAM, a mouse, and an accelerated video card.

It is fast, versatile and has the potential to expand and take on new challenges. Most of the interfaces
from the M200 system can be used with the M300. This allows the user to upgrade the chassis, CPU,
OS software and M300 software while using all the existing M200 hardware. The M300 uses the
same basic data format as the M200. It also has the same design philosophy as the M200, one version
of the software is customizable in order to fit multiple users.

PRODUCT OVERVIEW

    The Model 300 Data Acquisition System (M300) is a real-time, table driven, high-speed software
package designed to provide a true multitasking environment that has the ability to integrate
emerging hardware technologies.

    The M300 is based on the ISA/PCI BUS computer architecture which provides a standardized low
cost platform for development. With this form factor SEA engineers have developed the M300
software with an emphasis on scalability, versatility, and a wide range of configuration options. This
combination enables one version of the software to work with various hardware configurations and
meet multiple client research requirements.

    The wide range of configuration options extends from the variety of system hardware available, the
data acquisition source possibilities, data storage options, real-time computation advantages, and the
real-time display of data. Users specify what data they wish to acquire, the frequency they need, the
types of calculations to be performed on the data as well as how to display the results of those
calculations. All of these options combine to allow the end-user to create a seamless data acquisition
system designed to meet their specific requirements.

    M300 systems can range from entry-level systems with a few analog and digital channels mounted
in the back plane, through systems equipped with multiple CAMAC crates and direct memory access
(DMA) imaging interfaces. All hardware configurations can be run from the same software version
which provides the ability to add additional hardware without incurring the inconvenience or cost of
obtaining upgrades to the software.

   After a long research process Science Engineering Associates decided to develop the M300 based on
the Canadian born Operating System QNX (Kyoo-nix). QNX is not a direct decedent of UNIX, but
an evolved commercially developed Operating System similar to UNIX. QNX was chosen because it
is a real-time POSIX certified system distributed with a full array of networking tools including
TCP/IP and UDP. The Graphical User Interface (GUI) selected for the M300 was the proprietary
Photon Micro GUI. This GUI is well supported, user friendly, efficient, and works well with the
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QNX operating system to reduce system latency and minimize the effect on real-time applications. 

 Our vision is to provide a product that allows our customers a high degree of flexibility and
reliability that can help them to accomplish their research goals and outperform their competition.

MAJOR FEATURES

• A true multi-tasking environment with a GUI (Graphical User Interface).

• 4 GB of RAM maximum.

• A 90% interface hardware backward compatibility with the M200.

• No more command line interface. Almost 99% Graphical.

• Completely compatible with the M200 Data Format.

• Support for large screen resolutions. (i.e. 1024x768, 1152x864, 1280x1024, 1600x1200).

• Support for 8, 16, 24 and 32-bit true color.

• Simple text table setup.

• An integrated software modules for M300 (Main Application), M300 Manager (m300m), M300 Recording 
(m300r) M300 Broadcasting (m300b), M300 Print (m300p), M300 Control (m300c), M300 Shared 
Memory (m300s), M300 Log (m300l) and M300 Logger (M300Logger).

• “Point-and-click” application launch point.

• Support for an unlimited number of research project configurations. Users can select different 
configurations from the system.

• Project History List in the Project Menu.

• Support for automatic loading of last project.

• Support for an unlimited number of display windows (At least in theory!). Each window can be resized, 
moved or closed.

• Support for three possible data sources: Acquisition, Playback and UDP (Universal Data Protocol) for 
communication from another M300.

• A 1-second buffer. Other synchronous buffers faster then 1-second are possible.

• Support for Asynchronous buffers. M300 Async-buffer can acquire any acquisition event.

• New scheduling scheme with trigger, frequency and board.

• Simple board setup with specific dialog windows for each board type. Board hierarchy presented in a tree 
format for project.

• Simple acquisition setup with dialog window. Acquisition and board hierarchy presented in tree format for 
the project.

• Simple buffer setup with dialog window.

• Support for UDP (Universal Data Protocol) data broadcast during acquisition or playback modes.
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• Capability to write to binary file while playing back data.

• Capability to playback data from an open growing file on another system over the network connection.

• 10kHz System Frequency Ceiling.

• Individual computations and displays can be scheduled at different frequencies.

• ASCII file output backward compatibility with M200 with scheduling capability added.

• Built in system status/health information available for acquisition mode.

• Support for most of the existing M200 functions. Of course, new ones have been added as necessary.

• Support for all M200 mathematical functions as well as new ones.

• Support for double, float, signed/unsigned long, signed/unsigned integer, signed/unsigned char and string 
data types.

• All M300 windows have date and time information.

• All M300 windows have pause, grid toggle and print/capture buttons.

• Technically unlimited Strip Charts and X vs. Y plots per window.

• Enhanced capability to print/capture any M300 window.

• Data acquisition playback support via same software package.

• Can be configured to support more and more instruments with the corresponding displays.

• Support for analog input, digital input, 1D probes, 2D probes, 2D Grey Probes, GPS, LORAN, ARINC 
serial, INS synchros, Hail spectrometer, serial ASCII data, serial IEEE data, serial integer data, Sonic wind 
System, INS Accelerometer, Falcon data, HVPS probes, VAX clock, PMS 1058B 1D data, BC620AT time, 
DRV11 data, Ballard 708, AIMMS data, POSAV data, Network data and Pressure Multiplexer events.

• Storage to hard drive file.

• Control functions for digital output, analog output, 2D Mono TAS clock, 2D Grey clock, VAX time clock, 
INS INI and JW interlock.

• Probe channel tables.

• Output data to printer ports.

• Network data output to other systems.

• Telemetric data output.

• Storage of all configuration tables with raw data.

SYSTEM REQUIREMENTS

The following items are necessary as a minimum operating environment for the Model 300 Data
Acquisition System.
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REQUIRED

• Pentium II or better class processor.

• Accelerated Video Card (PCI).

• 128MB RAM minimum.

• 20MB free hard disk space.

• CD drive (installation only).

• QNX 4.25 Real-Time Operating System.

• SEA System Interface (M300 only). If SEA Interface not present can do acquisition on PC Clock mode.

• Mouse and Keyboard.

• Video card capable of 1024x768 for primary display. Secondary displays may be less resolution.

RECOMMENDED

• Pentium 4 or better class processor.

• 512MB RAM.

• SATA hard drive for data storage.

• USB ports for data transfer.

• Network Interface Card, 10/100/1000 Ethernet.

TYPOGRAPHICAL CONVENTIONS

Throughout this document, we use certain typographical conventions to distinguish technical terms.
The following table summarizes these conventions.

Reference Example

Commands cp /etc/config/sysinit

Menu Selections File (‘_’ indicates the shortcut letter)

Shortcut Alt + F, X (Hold Alt key while pressing F key, then press X)

Optional arguments []

Notes Note: This is an example of a note.

Warnings WARNING: This is an example of a warning
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A TRIBUTE TO THE MODEL 200

After years of trusted use the Model 200 Data Acquisition System (M200 DAS) is showing its age.
Developed for the DOS operating system (OS), for the past 12 years the M200 DAS has hit several
major limitations along the way.

• A limit of 640K memory available for program execution and data structures.

• No mouse support.

• Command line based system, no GUI interface.

• Limited screen resolutions to EGA (640x350) or VGA (640x480).

• Maximum of 5 colors (red, green, blue, black and white).

• Limited connectivity support via Network cards for data transfer to other machines.

• Minimal hard copy printing of M200 windows.

• Separate applications for Data Acquisition and playback

OUR HISTORY

    Several years ago we began considering what the next generation DAS should offer. Careful
consideration was made to offer backward compatibility, whenever possible, to hardware interfaces
and to maintain the basic M200 data format but additional functionality became the focus. We
placed priorities on a user-friendly interface, additional memory support, accelerated graphics,
improved control of computations and displays, as well as broadcast playback to other systems. 

    The M300 DAS project was created with these design goals in mind. The first point of
consideration was to find a suitable Operating System (OS) to host the M300. The most difficult
design goal was the use of a real time operating system. This requirement unfortunately eliminated
many popular home operating system possibilities. For example, all current versions of Microsoft
Windows including flavors of Windows NT. This was unfortunate because of the popularity and
general familiarity many users have with Microsoft operating systems but performance concerns
forced us to look for alternative options. From experience we knew DOS was an unacceptable
platform offering a number of limitations with both memory and user interface options. Other
options were eliminated immediately due to high cost or design limitations. Lynx OS, and Linux OS
were considered but found unsuitable for our design purposes through in house testing. 

Finally we chose to evaluate a system called QNX 4 by QSSL in Canada. We requested information
about their products (this was back in 1995 when the Internet was still in it's infancy) and received
some detailed information. The system looked like it could do what we wanted, but we wanted to
make sure it could deliver in key areas. QSSL was nice enough to let us evaluate their system and
even sent a package of cookies with the evaluation material.

First we wanted to make sure the system could handle the interrupts efficiently so we used an SEA
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System card and wrote a program to initialize the card and handle the interrupts. We measured
interrupt latency and were amazed with the numbers. We still had time left on our evaluation period
so Lyle decided we should try DMA operation as well as the interrupts to make sure the OS could
meet or exceed our expectations. We added a 2D Mono card to the system and developed software to
test the operation. With this data we knew we could handle DMA and interrupts beyond our
expectations. The only question left was, can we display the data? At the time, we tried X Windows
as the GUI. In no time, we added an X Windows application that would run 2D and display the
images. These tests eased any remaining concerns we had about the OS and we knew QNX 4 could
do the job. Our selection process was over for the OS but we still had to choose a Graphical User
Interface (GUI).

    QNX 4 has three options available (QNX Windows, X Windows and Photon) for a GUI. QNX
Windows was being discontinued and there were limited QNX 4 video drivers available for X
Windows. QSSL was putting all their efforts into developing Photon. After talking to several
engineers at QSSL and getting a better picture of what was going on in this area we choose Photon.

    So there you have it. We picked QNX 4 RT OS (UNIX-like, real-time POSIX certified) with the
Photon GUI for our M300 DAS from QSSL (www.qnx.com). Yes, it costs a little more than DOS,
but not as much as other operating systems we looked at. QNX also offers other options that we were
looking for, such as TCP/IP and NFS.

    Then, as luck would have it, Walter Strapp at MSC was looking to add a Forward Looking Radar
data acquisition and display to the M200 system. We wanted to please our client, but the M200 just
didn't have enough memory to handle this task. Since we had been playing around with QNX 4, we
thought it could do the job. So we did our first project for QNX 4. Because of time constraints and
against our better judgment, we wrote an application that was specific to the Forward Looking
Radar. QNX 4 performed great along the way, as did our new software application. After this, AES
came back to us and wanted to add the capability to have up/down/side antennas out of the Convair.
No problem, we said. The work was started for this, but there was a great empty feeling. We knew
there was a need for a new DAS, but at the same time, we were writing specific applications, that
required software changes to add new instruments and capabilities to the system. We had gone away
from one of the main design philosophies behind the M200 DAS. Before a lot of work was done, we
changed our minds and started work on the M300 DAS.

MODEL 300 DATA ACQUISITION SYSTEM IS BORN (CIRCA NOVEMBER 1999)

So what sets the M300 DAS apart from the M200?

• To start with, we don't have to deal with DOS anymore.

• Finally we have a robust real time OS to work with and a GUI. Oh! Look a mouse!

• We can now add as much memory to a system as we would like and be able to use it. Now we can dream!

• Almost all existing M200 hardware interfaces will be supported by the M300. This saves our users from 
having to buy a new set of hardware interfaces.
WELCOME12



M300 USERS GUIDE  SEA
• We did away with the command interface. Our users will not have to learn/remember any more M200 
commands.

• The M200 data format still rules. We have made some small changes that do not violate the basic M200 
data format (as you will see in the future). For example, all M300 buffers have a starting time as well as an 
ending time.

• Support for larger screen resolutions. The M300 will start at 1024x768 and go up from there (1152x864, 
1280x1024, 1600x1200).

• We have a lot more than 5 colors! The user can set the desired number of colors for the video mode (256 
colors, 16-bit color, 32-bit color). For speed constraints we will recommend staying at 256.

• Interfacing with the M300 is simple and easy.

• Similar text table setup as M200 software. Table names and contents are different than the M200 system. 
Sorry! We couldn't keep everything the same!

• Integrated software modules for M300 (main application), M300 manager (m300m), M300 recording 
(m300r) and M300 broadcasting (m300b).

• One click simple start operation. No complicated start sequence of different modules with corresponding 
parameters.

• Unlimited number of research projects configurations. User can select different configurations for the 
system, just by picking a different project.

• Project history list in project menu.

• File history list in file menu.

• M300 system automatically loads last project used. All window positions are remembered.

• Unlimited number of individual display windows. Each window can be resized, maximized, closed or 
minimized.

• Currently three possible data sources: Acquisition, Playback and UDP (Universal Datagram Protocol from 
another M300 system).

• One second buffer. Other synchronous buffers that are faster or slower than one second are possible.

• Asynchronous buffers. The M300 asynchronous buffer can acquire any acquisition event (aside from master 
and slave events).

• Each M300 buffer has a type to match the master acquisition event for the buffer.

• New scheduling scheme with trigger, frequency and board. Primary and secondary triggers available.

• Simple board setup with specific dialog windows for each board type. Board hierarchy presented in tree 
format for project.

• Simple acquisition setup with dialog window. Acquisition and board hierarchy presented in tree format for 
project.

• Simple buffer setup with dialog window. Buffer and acquisition hierarchy present in tree format for project.

• The M300 DAS supports UDP data broadcast during acquisition or playback modes.
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• During playback mode the user can write data to M300 binary file.

• Capability to playback data from an open growing file on another system over the network connection.

• Maximum system frequency of 10000 hz.

• Network data acquisition from sockets.

• Network data output via sockets.

• Individual computations can be scheduled at different frequencies.

• Individual displays can be scheduled at different frequencies.

• Capability to watch and alter any formula value.

• Same ASCII file output capabilities as M200 with scheduling capability added.

• Built in system status/health information available for acquisition mode.

• Support for all of the existing M200 functions. New ones will be added as necessary.

• New display types for Radar Reflectivity, Moving Air Mass, Hodograph and Skew-T displays.

• Improved Position display with wind barbs along track.

• The M300 supports all the M200 math functions as well as some new ones.

• Support for double, float, signed/unsigned long, signed/unsigned integer, signed/unsigned char and string 
data types.

• All M300 windows have date and time information.

• All M300 windows have a pause, grid toggle, print, properties and color buttons.

• Technically unlimited Strip Charts and X vs. Y plots per window. The M200 limited the user to 3.

• Enhanced capability to print any M300 window (printer output or bitmap file).

• Data acquisition and playback support via same software package.

• Capability to make upgrades to the M300 software to support more and more instruments with 
corresponding displays. The M200 development is halted due to severe memory limitations for executable 
source code and data structures.

We hope this gives you a good idea of what the M300 is all about. The system is doing well and
growing at a fast pace. At this stage of development, sometimes we get a great idea about making
things simpler and easier and are forced to make changes. Don't be alarmed if the next time you see
it, you can't recognize it!
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CONTACTING SEA

Should you need to contact SEA for any reason whatsoever, please select the most convenient means
from the following:

 -     Mail: 65 Industrial Park Road West
 -     P.O. 10
 -     Tolland, CT 06084

 -     Phone: (860) 454-7701

 -     Fax: (860) 454-7364

 -     Web Site: www.scieng.com

 -     E-mail: support@scieng.com
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GETTING STARTED

The following section is provided for users who wish to get up an running quickly. SEA recommends
that you read the entire users guide in order to become familiar with all of the basic functionality of
the M300.

INSTALLING QNX 4 SOFTWARE

It is nearly impossible to provide step-by-step instructions for setting up the M300/QNX system.
Depending on hard disk size and system configuration the installation steps vary. What might work
on some systems will not work on others. Here are some of the basic steps required to install QNX
onto a system. If you get stuck on a setup step consult the M300 Users Guide or the QNX
Documentation (Helpviewer) for additional help. There are sections in the Helpviewer
documentation for installing and setting up QNX and Photon. It’s strongly recommended that you
read these sections before proceeding.

QNX 4 boot image has to be within the first 1024 cylinders of the hard drive. The BIOS can only
search for the first 1024 cylinders of the hard drive for the boot image. Larger hard drives will have
more than 1024 cylinders.

In the BIOS you can enable LBA prior to installing QNX 4 (if supported). This remaps the drive
settings in such way that you have more heads and sectors but the cylinders stay less than 1024. This
doesn’t affect the size of the hard drive.

To install QNX 4 with guaranteed results you must install QNX 4 into two partitions. One small
partition (less than 100 MB) used to boot. The other partition hold everything else.

It is recommend to use the QNX 4 Product Suite 2010 CD (or latter version).

In systems with more than one boot OS it might be necessary to move/resize the other partitions to
make room for QNX 4. This is usually done with a program such as Acronis Disk Directory Suite.

1. It may be necessary to partition the hard drive to have empty space to install QNX. We
recommend at least 60 GB free space.

2. Change BIOS to allow the system to boot from a CD-ROM. When done, change BIOS back to
booting from hard drive. This should help boot the system faster.

3. Insert QNX Product Suite CD. Allow system to boot from CD.
4. Open shell.
5. Fsys -f 2000 -i 4000 -Hdisk160 &
6. Use fdisk /dev/hd0.0 to create one boot partition (100 MB) type 77.
7. mount -P /dev/hd0
8. dinit -h /dev/hd0.0t77
9. Perform the standard install for QNX 4.25, Photon 1.14 and TCP/IP. You will need to enter a

valid license for each one of these in order to perform the install. Use node 1 (default). Create the
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boot floppy. Don’t use boot directly into photon or probe for video modes at this time. Use
default settings for TCP/IP (no changes need).

10. With the 2010 CD, you have the option of installing TCP/IP 5.1. Check version and un-check
the earlier version of the TCP/IP 4.25.

11. After the install remove the CD and reboot. You should be able to login as root without a
password.

12. Follow instructions to create a new user with ID 101 (or greater) and group ID of 101 (See
“Adding User Accounts”  on page 37).

13. Change the ‘/etc/group’ file to add the “sea” group with an ID if 101.
14. Exit root shell by typing exit at the main command prompt.
15. Login as the user just created.
16. Run Photon from a user shell by typing ph at the command prompt. The first time you run

Photon, it will automatically run the video configuration utility. Pick the highest resolution
possible with 8 or 16 bit color.

17. Exit Photon and wait a few seconds for the disk cache to empty and reboot the system. Just make
sure you can login again and run Photon (‘ph’) without any problems.

SETTING UP QNX AFTER INSTALL

There are a few files that need to be modified and/or copied after the QNX install.

1. Copy the ‘/.licenses’ file from another node or edit the file to add all your licenses. Make sure you
backup this file first to ‘.licenses.bak’. Once this is done, check that the licenses have been
registered by typing licinfo -a at the command prompt. This will list all of the licenses
available under for each QNX package (see example below). The number next to each package
indicates how many licenses have been found. All QNX systems should have the same ‘/.licenses’
file and should contain ALL licenses for ALL machines.

upg     0/0  
dejav   0/0  
vgerx   0/1  
vger    0/4  
tcptk   0/2  
phab    0/1  
wcc     1/1   1
vedit   1/2   1
tcprt   2/17  1 16
phrt    0/15 
qnx     0/17 

2. Copy/modify the ‘/.profile’, ‘/.kshrc’ and ‘/etc/profile’ to match the files from another system.
Use a floppy to copy these files from another system.

3. You should use the same ‘/etc/group’ and ‘/etc/passwd’ files for all QNX systems. You can use a
floppy to copy these. This step should only be done after the system is totally installed and
everything is working okay.
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CHANGING THE M300 NODE NUMBER

When you install QNX by default we use node 1 for the install. After the install, if necessary, you can
change the node number. If you have more than one system and would like to network them
together, then they all must have different node numbers. The largest node number must be less than
the total number of licenses you have. For example if you have 4 QNX licenses, then you can have
nodes 1, 2, 3 and 4. It’s not possible to setup nodes 1, 2, 5 and 6 even though this is still only 4
nodes.

Note: This entire process must be done as superuser.

1. Change directories to ‘/boot’ by typing cd /boot at the command prompt.
2. Copy the current ‘hard.node’ or ‘install.node’ file to a new ‘hard.newNode’ file. For example, say

we want to change the node number from 1 to 2, copy the ‘hard.1’ or ‘install.1’ file to a ‘hard.2’
file by typing cp /boot/build/hard.1 /boot/build/hard.2 at the command prompt.

3. Then edit the new file by typing vedit /boot/build/hard.2 at the command prompt, and
change the Proc32 line. The ‘-l 1’ option sets the node number. We want to have ‘-l 2’ instead
(see lines bellow).

Before edit

/boot/sys/Proc32
$ /boot/sys/Proc32 -l 1 -P 28

After edit

/boot/sys/Proc32
$ /boot/sys/Proc32 -l 2 -P 28

4. Run the ‘buildqnx’ command to rebuild the ‘.boot’ file by typing buildqnx /boot/build/
hard.2 /boot/images/hard.2 at the command prompt, or whatever node numbers you have
chosen. This creates the new boot image file.

5. If there was no problems during the build, copy this file to the ‘/.boot’ file by typing cp /boot/
images/hard.2 /.boot at the command prompt. This will overwrite the old boot
information. If using ‘/hd/.boot’ file instead to boot, you should copy to that file.

6. Restart the QNX system by typing shutdown -f at the command prompt. If the SEA software is
installed, you can type reboot to restart the system.

7. If the system hangs or fails to boot, turn off the power to the system and turn back on after
waiting approximately 10 seconds. When the prompt to perform an altboot comes up, hit ESC
and this will run the alternate booting configuration. Fix the problem with the ‘/.boot’ file and
try to boot again. If this still fails, contact SEA (See “Contacting SEA”  in  on page 15).

8. Once the system has booted, login as any user and verify the new node number by typing sin in
at the command prompt. This should give you the new node number.
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GETTING THE SYSTEM ON THE NETWORK

It’s important to have a network card that is supported by QNX. You should just follow the
instructions in the QNX Install section for getting your network card setup. We don’t use the
netmap file. We use the ‘automap’ utility. The ‘automap’ is in the ‘/usr/bin’ directory. Here is a
common example

Net &
Net.e1000 &
automap -N -X -d1000 -D1000 &

After this you can test that the network is working by typing alive at the command prompt. This
should report all the nodes you are using. In addition you can list the files on another node, for
example ‘ls //1’ will list all the files on node 1.

INSTALLING M300 SECURITY

Note: Is is assumed that security has been pre‐installed on all M300 systems. However, a time may arise
where security must be re‐initialized and/or reinstalled. These procedures are meant to guide through this
process.

1. Connect the M300 Security i-Button Adapter to an available serial/com port. Ensure the i-
Button security device is correctly seated in the adapter. The i-Button can be identified by the
M300 serial number label on it. This is the assigned serial number for your unique software
license. Write it down, as you will need it later on.

2. If necessary, copy the ‘.key’ and ‘.bolt’ files to the M300 system by doing the following:
a.) Ensure the files you are copying have the same serial number as the i-Button. For instance, if 

you have the files ‘.key.3020’ and ‘.bolt.3020’, you must be using an i-Button with a serial 
number of 3020. Neither the M300 software, nor most of the SEA Utility applications will 
work without these serial numbers matching.

b.) Depending on how you received the files (i.e. E-mail, CD-ROM, FTP, etc.), each different 
method requires a different way to copy the files to the QNX machine running the M300 
software. Refer to the necessary QNX documentation for this.

c.) Log into a shell as superuser by entering su - at the command prompt. The default password 
is then ‘seaXXXX’ where XXXX is the four digit serial number of the M300 system. This 
should be the same as the serial number on the i-Button.

d.) At the root command prompt, copy the files to the /sea directory by entering                          
cp filename /sea/. where the ‘filename’ is whatever file you wish to copy. For instance, to 
copy the ‘.key.3020’ file, type cp .key.3020 /sea/. at the command prompt. Next enter 
ls -la /sea to ensure that the files were successfully copied to this directory. Note that if 
the files came from a Windows based machine, it is possible they had to be renamed in order 
for Windows to store them. You must rename the files to the following format: ‘.key.serial-
Num’ and “.bolt.serialNum’ where serialNum is the respective serial number of the  i-Button. 
Do this by entering mv oldFileName newFileName where ‘oldFileName’ is the name of 
each key and bolt file and ‘newFileName’ is the respective new key and bolt filename as 
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described. For instance, to rename the ‘.key.3020’ file after copying from a windows machine, 
type mv key.3020 .key.3020 at the command prompt.

e.) It is now most likely necessary to change the permissions, owner and group assignments of the 
files. Change the owner of the files by entering chown root .*.serialNum again, where 
‘serialNum’ is the 4-digit serial number. Change the group of the file by entering chgrp root 
.*.serialNum at the command prompt. Finally, the permissions need to be set to  ‘rw-rw-
rw-’. Do this by entering chmod 666 .*.serialNum at the command prompt. Finally enter 
ls -la and ensure the two security files have the following attributes:
rw-rw-rw-       root    root     modifedDateTime   .key.serialNum
rw-rw-rw-       root    root     modifedDateTime   .bolt.serialNum

f.) If the files do not have the above attributes. Go back through the directions and make sure all 
steps were followed correctly.

3. At this point, we are ready to initialize the M300 with the new security codes. First, ensure that
the security is not running by entering slay security at the command prompt. Next, start the
Security program by clicking on the icon in the Desktop Manager under the SEA tab. (See
“Getting Familiar with Photon”  on page 27). Alternatively, to start from a shell, enter Security
& at the command prompt.

4. When the Security application begins, you may or may not see anything in the text boxes. First,
enter the device name that the i-Button adapter is connected to in the Port field. For instance, if
you have the adapter connected to serial port one, you would enter /dev/ser1 in this field.

5. Next, in the Serial Number field, enter the 4-digit serial number of the i-Button as described
above. Hit Enter. All of the codes for the software, as well as the Password, Client Name and the
i-Button serial number should be displayed. If the codes, password, client, etc. are not displayed
after pressing Enter, then there is a problem. This can be an invalid ‘.bolt’ or ‘.key’ file, or an
incorrect serial number.

6. Click on the Save button on the menu bar. This will create the security configuration file
(security.cfg).

7. Use the ‘system’ utility to check the M300 security by typing system -check at the command
prompt. The system utility will point out problems with install, like missing directories and
invalid permission settings for files. Here is a sample output of the ‘system’ utility.

System Check Utility Version 1.09.03 15:19:40 Sep 29 2003
(c) Copyright SEA, Inc. 1998-2003. All rights reserved.
Software licensed to SEA, Inc.
System Board Found at Address 0x0300
Checking user info for operator
Serial Number (from security.cfg file): 3002
Port: /dev/ser1
PATH variable okay, /sea/bin found
Checking security
Serial Number: 3001
Client: Anywhere University
Password: 43C724F012521ABB2
iButton: AF11113FE2E5F2B18
Acquisition: 1
Playback: 1
Utilities: 1
Mono: 1
Grey: 1
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Hvps: 0
Falcon: 0
Spp: 0
Caps: 0
Piraq: 0

INSTALLING M300 SOFTWARE IN QNX SYSTEM

Once QNX is setup and is connected to another node (system), the M300 software can then be
copied from the other system. Follow these steps to install the M300 software.

1. Create the ‘/sea’ directory. As root type mkdir /sea at the command prompt. Next, as root type
chmod 777 /sea to set the proper permissions.

2. We have two directories where we keep most of the software. The /sea/bin is used for most of the
main M300 software applications. The /sea/bin2 can be used for other software including user
scripts.

3. Copy the ‘/sea’ directory from another node. For example to copy the ‘/sea’ directory from node 1
type cp –pR //1/sea /sea at the command prompt. This will copy the ‘/sea’ directory and the
‘/sea/bin’ directory.

4. Create a ‘.sea’ directory under the user home directory. For example, if the user name is ‘operator’
then login as operator (See “Login”  on page 27). You should then be in the directory ‘/home/
operator’. You can type pwd to verify this (print working directory). To create the directory, type
mkdir /home/operator/.sea and then chmod a+w /home/operator/.sea at the command
prompt. This will create the directory and set the necessary permissions.

5. Copy the ‘.photon’ directory from another user. For example to copy the ‘.photon’ directory from
operator on node 1 type cp –pR //1/home/operator/.photon /home/operator/.photon
at the command prompt.

6. Next, copy all of the setup files for the M300 projects. This includes the following directories.

/1999
/2000
/2001
/2002
/2003
/2004
/2005
/2006
/2007
/2008
/2009
/2010
/2011
/chn
/maps
/probes
/m300
/m200
/test
/home
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For example, to copy the entire ‘/test’ directory, type at cp -pR //1/test /test at the command
prompt. You should repeat this command for all the directories listed above (assuming you have
these). You should also copy any other directories that you might have with M300 project
configuration files or data.

7. Exit and restart Photon. Upon reboot, you should see the SEA tab and all of the program icons
for the M300 software.

UPDATING M300 SOFTWARE IN QNX SYSTEM

Assuming the M300 software had already been installed in a system, the SoftTool application can/
should be used to update the M300 software.

Please refer to the Sea Utilities User’s Guide to see the documentation for the SoftTool and how to
use it.

With the SoftTool you can copy the software from one machine on the QNX network to another.
You can also install the software from the sea.tar.gz file.

QNX SAMPLE FILES

The following is a sample of the more important setup files for QNX system.

/.kshrc

alias m300t='sudo ntpdate 132.163.4.102;M300'
alias m300='M300'
alias vp='vedit'
alias cp=’cp -i’
alias copy=’cp -i’
alias del=’rm’
alias ff=’find -name’
alias ls=’ls -vCF’
alias dir=’ls -laF’
alias df=’df -h’
alias du=’du -a -p’
alias su=’su -’

/.profile

export PS1='$PWD%'
export PATH=$PATH:/usr/photon/bin
export LPSRVR='/qnx/PhSpool'
export LPDEST='c'
export ENV='$HOME/.kshrc'
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/etc/passwd

root::0:0::///:/bin/sh
augie:x:101:101:Augie Henriques:/home/augie:/bin/sh
lyle::102:101:Lyle Lilie:/home/lyle:/bin/sh
chris::104:101:Chris Sivo:/home/chris:/bin/sh
dan::105:101:Dan Bouley:/home/dan:/bin/sh
operator::110:101:M300 Operator:/home/operator:/bin/sh
seaftp:x:111:101:FTP:/home/seaftp:/bin/sh

/etc/group

root::0:root
mail::40:
sea::101:

/etc/profile

# startup profile executed by shell during login
export PATH=$PATH:/etc:/usr/ucb:/usr/local/bin:/sea/bin:/sea/bin2 TMP-

DIR=${TMPDIR:-/tmp}
export SYSNAME=${SYSNAME:-qnx4}
if [ "$LOGNAME" != root ]; then
  MAIL=${MAIL:-/usr/spool/mail/$LOGNAME}
  test -s $MAIL -a $MAIL -nt .lastlogin && echo "You have new mail. "
fi
if [ -f .hushlogin ]; then
  echo -n >.lastlogin
else
  test /etc/motd -nt .lastlogin && cat /etc/motd
  test -s .lastlogin && echo $(<.lastlogin)
  echo "Last login: ${DATE=`date +%c`} on ${TTY=`tty`}" >.lastlogin
  echo $DATE
fi
alias lf='ls -CF'
stty quit ^\\
umask 2
LANG=C

/etc/netstart

export SOCK=$NODE
/bin/slay -f Tcpip;
/bin/prefix -D /dev/console >/dev/null 2>&1;
/bin/prefix -A /dev/console=/dev/con1;

/usr/ucb/Tcpip q4sn3001 &

/usr/ucb/ifconfig en1 192.9.200.1 up
/usr/ucb/ifconfig lo0 localhost up
/usr/ucb/ifconfig en1 broadcast 192.9.200.255
#/usr/ucb/route add 224.0.0.0 192.9.200.2
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#/usr/ucb/route add 225.0.0.0 192.9.200.2
/usr/ucb/route add default 192.9.200.40
# /usr/bin/syslogd

# Note:  to act as an NFS server, uncomment the next line
# /etc/nfsstart

# Note:  to act as a TCP/IP server, uncomment the next line
/usr/ucb/inetd &

/etc/services

This is the end of the /etc/services file where we typically make the modifications for the M300
systems.

#
# QNX services
#

phrelay         4868/tcp

#
# SEA
#
sea-udp         2000/udp
radar-udp       2001/udp
sea-tunnel      2005/tcp
sea-tunnel      2005/udp

#
# WCM-2000
#
wcm-primary     2100/tcp
wcm-primary     2100/udp
wcm-secondary   2101/tcp
wcm-secondary   2101/udp
wcm-tertiary    2102/tcp
wcm-tertiary    2102/udp
wcm-quaternary  2103/tcp
wcm-quaternary  2103/udp
wcm-input       2110/tcp
wcm-input       2110/udp

nrc-data        4010/udp
nrc-data        4010/tcp
msc-pass3       4011/udp
wmo-radio       4012/udp
msc-radaralt    4015/udp
msc-radaralt    4015/tcp

#
# Palas
#
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promo2000      56790/udp
promo2000      56790/tcp

#
# POS/AV
#
pos-display5600/udp
pos-control5601/tcp
pos-primary5602/tcp
pos-secondary5603/tcp

#
# Neutrino specific services
#
pidin           557/tcp         nto_pid_info # Neutrino system information
pidinmem        558/tcp
pidinarg        559/tcp
pidinenv        560/tcp
pidinsig        561/tcp
lpidinmem       562/tcp

/etc/config/sysinit

set -i
export KBD=en_US_101.kbd
export ABLANG=en
export CON_KBD=USA
export TZ=est05edt04,M3.2.0/2,M11.1.0/2
#export TZ=UTC00
#export PHWMOPTS="-K"
rtc hw
ticksize 1
Dev &
Dev.ansi -Q -n 6 &
reopen /dev/con1
# Sealevel systems, 4 Port PCI, IRQ 9
# Dev.ser -F 3f8,4 da00,9 d800,9 d600,9 d400,9 -t1 &
# Dev.ser -F 3f8,4 dc00,9 e000,9 e400,9 e800,9 -t1 &
Dev.ser -F -t0 &
# Blue Heat PCI
Dev.bh -I 16384 -O 4096 -F -t1 -N /dev/ser2 &
# NT960 PCI serial
#Dev32.nt960pci -I 4096 -O 4096 -F -N /dev/ser2 &
# Bluestorm PCI serial
#Dev.bluestorm  -I 4096 -O 4096 -F -t0 -N /dev/ser2 &
#Dev.par -P 7 &
Dev.pty -n16 &
Iso9660fsys >/dev/null 2>&1 &
(
export PATH=$PATH:/usr/photon/bin
phfont -X &
lpsrvr -f/etc/config/lpsrvr.photon &
)
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Pipe &
emu87 &
kbd $CON_KBD
prefix -A /dev/console=/dev/con1
Net &
Net.e1000 -d1075 -l1 &
#Net.bege100 &
###Net.rtl8169 -l2 &
#Net.bege100 -l2 &
# next line is for Intel 10/100/1000 network board
#Net.e1000 -d107C -l2 &
sleep 2
automap -N -X -d1000 -D1000 &
sleep 2
#/sea/bin/security &
# set /dev/ser9 to RS 485, half duplex, 2 wire mode
#ctty +rts +rxd </dev/ser9
netstart
# get time
#ntpdate 132.163.4.102
#ntpdate 132.163.4.102
# start ntpd
#xntpd -c /etc/ntp.conf &
# Blueheat net default initialization using /etc/bhn.conf
#Dev.bhn -I 4096 -O 4096 -F -N /dev/ser2 &
# Blueheat net 8 port initialization using /etc/bhn.8.sn6269.conf
# If running more than one box, name ports using the -N option
#Dev.bhn -c /etc/bhn.8.sn6269.conf -I 4096 -O 4096 -F -N /dev/ser10 &
# Blueheat net 2 port initialization using /etc/bhn.2.sn3614.conf
# If running more than one box, name ports using the -N option
#sleep 2
#Dev.bhn -c /etc/bhn.2.sn3614.conf -I 4096 -O 4096 -F -N /dev/ser10 &
#sleep 2
#Dev.bhn -c /etc/bhn.2.sn5649.conf -I 4096 -O 4096 -F -N /dev/ser12 &
#freeze -cdz /etc/logo.F
#tinit -T /dev/con* -c "login operator" -t /dev/con1 &
tinit -T /dev/con* -t /dev/con1 &

/boot/build/hard.4

/boot/sys/boot
$ /boot/sys/boot -v

/boot/sys/Proc32
$ /boot/sys/Proc32 -l 4 -P 28 -p 2000 -f 16 512 16000

/boot/sys/Slib32
$ /boot/sys/Slib32

/boot/sys/Slib16
$ /boot/sys/Slib16

/bin/Fsys
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$ /bin/Fsys -f 2000 -i 4000 -Hdisk500

/bin/Fsys.atapi
$ /bin/Fsys.atapi

/bin/mount
$ /bin/mount -p /dev/hd0 /dev/hd0t78 /

/bin/mount
$ /bin/mount /dev/hd0t77 /hd

/bin/sinit
$ /bin/sinit TERM=qnx

LOGIN

In the QNX 4 system there are users assigned to the system. Each user has a login name and
password. To login into the QNX system:

1. Enter you username at the login prompt.
2. Enter you password at the password prompt.

WARNING: If you are going to run the M300 during this session, you should NOT login as root/superuser.
Rather, you should set‐up a user account (if not already done so) with reasonable access rights and privileges.

Note: If you enter an incorrect or non‐existent username/password, for security reasons, QNX will return to
the login prompt without providing notification of the error.

LOGOUT

To logout from the QNX system

1. Type exit or logout at the QNX 4 command prompt.

STARTING PHOTON

To start the QNX Photon GUI

1. Type ph at the QNX 4 command prompt (first you must login).

Note: The system can be configured to start Photon automatically after boot up as opposed to the
traditional login through the QNX 4 shell. If you wish to have this, just contact SEA for help on getting it done.

GETTING FAMILIAR WITH PHOTON

The QNX Photon GUI (Graphical User Interface) has a similar interface much like any GUI you
might be familiar with already, with the exception that it is designed for a real-time operating system.
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It is because of this real-time requirement that some of the special features of modern day GUI are
not available in the Photon GUI. With that said, Photon still provides scalable graphics support,
multimedia capability, and a fully customized interface. Below is a snapshot of the Photon desktop
along with the highlighting of its main features.

QNX DESKTOP

Note: This section will provide you with an overall description of main Photon GUI features, to get more
help on the Photon GUI, please see the Photon documentation in the QNX Helpviewer (See “Getting Help for
QNX 4 and Photon”  on page 31).

QNX Helpviewer
This is the application you will use to view any electronic QNX Documentation.

QNX Logo Button
This is similar to the start button on Windows GUI. However this button will only give you access to
system configuration dialogs and the Shutdown command.

Desktop Manager  
This is where any Photon applications can be launched from. By default, QNX has a handful of
different tabs for various applications on this menu bar. This is where you will find the SEA Tab.
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Photon Task Bar
This is where any running application’s buttons will displayed. For SEA applications, each window
will have a corresponding button on this taskbar. To bring a particular window into focus, click on
its task button.

Note: It’s recommend to resize the task bar and make it larger (two rows high). The task bar in Photon is
similar to the one in Windows systems. The larger the task bar the more windows/applications running you
will be able to see.

Note: If you are running multiple M300 sessions or have a very large number of displays, it might be wise to
setup the task bar to auto hide. See Photon documentation for Photon Windows Manager (PWM).

Applications Tab
From the applications tab you can launch the two mostly used Photon applications. The first icon it
for PTerm and the second is Helpviewer.

PTERM, SHELL, TERMINAL WINDOW, COMMAND WINDOW

This is a QNX shell (pterm window) that will provide you with an interface to enter command
directly into the QNX system. When you enter a command in the QNX shell, what you see here is
exactly what you would see had you entered a command without starting Photon first. This shell can
also be used, as you will find out through out the M300 users guide, to launch applications and
QNX utilities.

The shell windows is also referred to as command window and terminal window.
GETTING STARTED29



SEA M300 USERS GUIDE
HELPVIEWER

The Helpviewer will give you all the documentation for the QSSL software install in the system. The
main parts are the QNX 4 OS, Photon GUI and the TCP/IP.

Utilities Tab
From the utilities tab you can launch the Snap Shot Photon application.

SNAPSHOT

The Snap Shot allows you to capture any Photon window or the entire Photon work space to a
bitmap file.

When you capture a window, pick BMP Spool File from Printer, type the file name (*.bmp) in
Location, pick Selected Window from the Select Snapshot Type, click Begin button, and then click
on the title bar for the window. This gives you the entire window. If you click inside the window
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area, you will only get the internal part of the window, without the title bar area of the window.

SEA TAB

This is where you will find the program icons for any SEA software, including the M300.

EXITING PHOTON

You can exit Photon using a couple of different commands.

1. Click on the QNX logo in the bottom left corner of the screen, and select Shutdown.
2. Don’t use the CTL + ALT + SHIFT + BACKSPACE key combination to shutdown photon.

Note: We had to disable this option on SEA M300 installed systems. The key combination exit is not the
same as mouse exit on the QNX button. As a result applications don’t get shutdown the way they should and
cause problems with bad values on files, etc.

Note: Once you exit Photon, you will return to the QNX 4 command prompt or to the Photon login screen if
your system is configured to start Photon automatically.

GETTING HELP FOR QNX 4 AND PHOTON

The QNX 4 system does not provide man pages like in traditional UNIX systems. To get help on a
command, type use cmd where ‘cmd’. . is the command in question. For example, for help with the
‘ls’ command, type use ls at the command prompt from a ‘pterm' window). Help is also available
using the Helpviewer Photon application. To get help on any QNX 4, TCP/IP 5 and Photon 1.14
issues consult the Helpviewer using one of the following methods.

1. In the Desktop Manager, select the Applications tab in the application groups panel. Click on
the Helpviewer icon.

2. From a QNX shell, type helpviewer.
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WORK SPACE

The Photon work space is made of nine virtual consoles. Only one console can be visible at a time.
The user can place any window running on any of these consoles. See the Photon Users guide for
help with this.

When we run M300 system, we will place display windows on any consoles we desire. This allows to
have many display windows open and change quickly between different aspects of the M300 project.

EDITOR

The editor is a key component of using the M300 system. The user will spend a considerable amount
of time editing project setup files and looking at other text data (ASCII).
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For those users you are experienced and have a favorite editor, go ahead an use whatever editor you
are familiar with. Assuming this editor is available for QNX 4 (such as vi, emacs, etc).

For everyone else we recommend using Vedit editor. It’s simple, menu driven and very familiar to
DOS/Windows editors. Some of the function keys are very similar, etc.

It’s not recommend to use wordpad (in Windows) to make changes and bring the files into QNX 4
system. If the original files used special character from the ASCII keyboard table (such as degree
symbol or micron), these will not be correct. Wordpad doesn’t support those ASCII symbols.

In QNX 4, with vedit, you can only copy/paste inside the same terminal window. You can’t copy on
one terminal window running vedit and then past on another window also running vedit.

Here are the basics for vedit.

1. To edit a file, for example temperature.cfg, just use vedit temperature.cfg This assumes that
you are in the correct directory on a PtTerm window.

2. There is also an alias we setup for vedit, called ‘vp’, so you can also use vp temperature.cfg
3. If you want to open several files, vp [file1] … [filen]
4. There is also a script to edit M300 project files. M300 project files are usually three letters

followed by ‘.300’. The script name is ‘e’. So if you want to edit the formula table (fml.300), you
just type ‘e fml’. The script makes the substitution and calls ‘vedit fml.300’ (saving you from
typing a lot of characters). If you want to edit a board file, for example fssp.brd, then you can’t
use ‘e fssp’, since this would try to open the fssp.300 file. This file doesn’t exist. So you actually
have to type vp fssp.brd to edit the fssp.brd file.

5. To exit the editor use ALT + X key combination. If the file was changed you will be asked to save
or not.

6. To move in the editor, use the normal cursor keys (left, right, up, down, page up, page down,
home, end, etc...). You can also use the mouse to position the cursor on a different section of the
document.

7. Begin of a line use, home key.
8. End of line use, end key.
9. Switch between open files forward F6.
10. Switch between open files backward F5.
11. Menu use F10.
12. Search use F2.
13. Search again, use F3.
14. Search and replace, Click on the search menu.
15. Save a file, ALT + F, S
16. Undo, CTRL + Z or ALT + BACKSPACE
17. To select, use mouse or use keyboard to position start and then hit F9 then mouse cursor again.
18. To copy: CTRL + C.
19. To cut: CTRL + X.
20. To paste: CTRL + V.
21. To select all: CTRL + A.
22. To delete the current line: CTRL + X (no selection necessary).
GETTING STARTED33



SEA M300 USERS GUIDE
23. To delete to the end of a line: CTRL + K.
24. Use view menu to switch to hex mode when looking at binary data.
25. To insert special characters (such as degree and micron symbols) use the ‘misc’ menu, ASCII

TABLE menu item.

HOW TO START M300

Start the M300 DAS using one of the following methods.

1. In the Desktop Manager, select the SEA tab in the application groups panel. Click on the M300
icon.

2. From a QNX shell in, type m300. This is a script which initiates the M300 DAS. Alternatively,
you can start the M300 directly by typing M300 & at the command prompt.

MAIN WINDOW

The M300 Main Window is the primary launch point of all M300 operations. Both Acquisition and
Playback as well as UDP can be performed now from a single window. The M300 data displays can
be directly managed from this window as well as formulas and almost all project settings. If you wish
to learn more about each control/feature (See “M300 Main Window”  on page 53).

HOW TO EXIT M300

Exit the M300 by using on of the following methods.

1. From the File menu, select Exit. (Shortcut: Alt + F, X) or click on the close symbol (“X”) in the
upper right corner of the main interface window. 
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2. If there were any changes made while the M300 was open, an option to save changes will be
given. Select Yes to save changes, or No to exit without saving any of the changes made. (this
saves the project only, not the data files).

Note:  If the M300 system freezes for any reason, you can close the program by typing m300k from a QNX
shell. However, this will not allow you to save any changes you have made since last saving your project. Use
only as last resort to close the program.

SHUTTING DOWN THE M300 SYSTEM

Shutdown the M300 system by performing the following.

1. Exit all applications, including M300 and Photon if they're running
2. Once you are in the QNX 4 shell just type exit to logout.
3. After a few seconds (to be sure wait 3 to 4 seconds) you can turn the power off. This will give the

cache enough time to empty out to disk.
4. Or you can type halt prior to shutdown from either a PtTerm window or the QNX shell before

login out.
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GENERAL INFORMATION

The following sections will provide the user with some helpful basic information about using
common QNX utilities as well as general knowledge about the QNX Operating System. SEA
recommends that you read the entire users guide in order to become familiar with all of the basic
functionality of the M300.

USING SUPERUSER/ROOT

There are certain tasks that can only be performed by the super user. The super user has a ‘root' name
and it belongs to the ‘root' group. This means when you log on you will not have limitations on your
user privileges. Without administrative limitations it is easy to create problems with your QNX
system which is why it is highly recommended that you sign on as root only when carrying out
activities that require root access. There are a couple of different ways to do this, but the quickest
change from user to superuser is by using the su command. 

Note: When working on a QNX 4 system it's highly recommended that you commonly login with user
privileges and only use root access when necessary.

1. To become super user, type su - at the command prompt and then type the password for super
user when prompted. 

2. Alternatively, there is another way to run a command as super user. This is done using the super
user do utility ‘sudo'. To run a command as super user the ‘sudo' utility must be setup properly
prior to using it. For more information on the ‘sudo’ command, (See “Getting Help for QNX 4
and Photon”  on page 31). To run a command as super user just type sudo [command] at the
command prompt. For example, type sudo shutdown -f at the command prompt. If this
doesn't work, either you don't have the sudo utility or it's not setup correctly.

3. To exit superuser, just type exit at the command prompt. You should become regular user again
on the current shell.

UNDERSTANDING THE BOOT PROCESS

When QNX begins the boot process, an image composed of several processes is loaded into main
memory. The first process is boot, which does real-mode initialization and then places the machine
into protected mode.

The second process in the image is the Process Manager ‘Proc32’, which contains the Microkernel.
The Process Manager performs processor initialization, and then schedules each process included
within the image for execution.

The last process in the image is the ‘sinit’ utility. The ‘sinit’ utility initiates the second phase of
system initialization by starting a shell that executes for a machine. It's a standard shell script that
runs just like any other shell script except that breaks are disabled. When ‘sinit’ runs, it firsts
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determines if the image it's part of was booted from disk or from over the network. If the image was
booted from disk, ‘sinit’ checks to see if a normal boot or an alternate boot occurred. 

The aforementioned QNX modular setup allows users to start system services after boot. The booted
image typically only contains the services needed to start the other services.

During a normal boot, sinit tries to boot from the ‘/etc/config/sysinit.node’ file. During an alternate
boot (from local disk only), ‘sinit’ tries to boot from the ‘/etc/config/altsysinit file’. If it can't boot
from either of those files, ‘sinit’ will try to boot from the ‘/etc/config/sysinit’ file.

If ‘sinit’ can't find or open a system initialization file, it terminates without initializing the system. If
the open succeeds, sinit replaces itself with the shell ‘/bin/sh’ and passes to it the name of the file that
‘sinit’ opened.
It is recommended to use the ‘/etc/config/sysinit’ file. This saves the work of having the right node
file configured for the system (is it ‘/etc/config/sysinit.1’ or ‘/etc/config/sysinit.2’, etc.).

CHANGING YOUR PASSWORD

The passwd utility is the focal point for password administration and access. It can be used to change
passwords or to add a new user account to the system. Anyone can change their own password, but
the superuser (root) is the only user who has the right to create or change other passwords. In both
cases, the passwd utility locks access to the user password file /etc/passwd to prevent any other
attempts to access the file while it's being modified. 

1. If you are logged in as a user and you want to change your password, type passwd and you will
be prompted to change your password.

ADDING USER ACCOUNTS

1. If you are logged in as root and you want to add a user, type passwd username at the command
prompt. The ‘username’ being the name of the user you wish to create. By default, passwd will
then prompt for the following information:
a.) User ID. User ID ranges are set in the ‘/etc/default/passwd’ file (101 or greater).
b.) Group ID (101 for SEA).
c.) User's real name.
d.) User's home directory. A default home directory of /home/username is used (it's created if it 

doesn't exist).
e.) Initial command. The default the shell startup command ‘/bin/sh’ is executed immediately 

after the user logs in
f.) Initial password. User defined. If none is input, the account will be created without a pass-

word assigned to it.
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Note: ID numbers are numbers given to each user account or group account for identification and should be
assigned an ID number greater than 100. ID numbers below 100 are often used by system processes and
should be avoided. Also, The home directory, initial command, and initial password items are optional. If you
don't specify them, the default values are used. For password, the default is no password.

2. If you wish to change the default profile settings QNX uses, the easiest way to do this is to copy
another users profile settings to the new account by performing the following copies (note that
some files may not exist).

cp -pR /home/augie /home/username

DELETING USER ACCOUNTS

To delete an account, you must log in as the superuser and remove the following.

1. The user database entry from the ‘/etc/passwd’ file.
2. The username from the corresponding group Id membership entry in the ‘/etc/group’ file.
3. The corresponding encoded login password entry from ‘/etc/shadow’ file.
4. The user's home directory (optional).

ADD SEA GROUP

Edit the /etc/group file and make sure it looks like the following.

root::0:root
mail::40:
sea::101:

RECOMMENDATIONS FOR A REAL‐TIME DATA ACQUISITION SYSTEM

Below are some points of careful consideration whenever running a computer system with real-time
data acquisition requirements.

• There are certain applications that may interfere with the real-time performance of the M300 data 
acquisition system. You must avoid running these applications when the M300 system is running in 
acquisition mode.

• As a general rule, the user should not be running any other applications unless it absolutely necessary while 
the M300 is running in acquisition mode.

• Do not run the ‘Dosfsys’ or ‘Fatfsys’ applications while the M300 is running in acquisition mode.

• Do not enable or run the screen saver while the M300 is running in acquisition mode.

• IRQ, DMA and Address conflicts will prevent the M300 from operating properly. The problems caused by 
IRQ, DMA and Address conflicts can be at the board level or at the system level depending on the 
particular situation.
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• SEA configures the M300 systems with no conflicts for IRQ, DMA and Address. The user is allowed to 
make modifications to the systems by adding/removing and reconfiguring hardware interfaces. Special care 
must be taken to ensure that no conflicts are introduced.

MULTIPLE MONITOR SUPPORT

Photon supports multiple monitors using more than one video card. This is a very advanced topic
and must be configured by SEA engineers. If you wish to have more than one monitor per system
please contact SEA.

PSEUDO MONITOR SUPPORT

It's possible to have more than one display per system using the QNX 4 native networking. Several
systems can be connected together and they can view similar or different projects within the same
data file (real-time). Also the M300 has the capability to broadcast the data out to several different
clients.

SWITCH PHOTON CONSOLES

The Photon workspace has a total of 9 different consoles (virtual consoles). The user can place any
window in any place on the Photon workspace.

One quick way to switch between the different sessions is to use ALT + CTL + # (where # ranges
from 1-9).

Check the Photon documentation for more information on this (See “Getting Help for QNX 4 and
Photon”  on page 31).

REQUIRED PHOTON SETTINGS

Full window drag must be turned off. This feature has two undesirable side effects. One slow draw
for window move/drag. Two maximize and restore of a window in Photon has a bug when this
feature is enabled.

ACCESSING FILES FROM ANOTHER NODE

In QNX 4 systems all the machines on the QNX 4 network can be connected together. When they
are connected together, the file system on other nodes can be seen/used very easily. Typical nodes are
//1/, //2/, //3/, etc.

To access a file on a remote machine, you'd precede a path name with the remote machine's node
number. For example type cd //3/ at the command prompt, to change directory to root on node 3.
This command would allow the user to access files located on node 3. If you wish to return the shell
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to your current file system, type cd / and you will be returned to the root folder of your file system.

ALIVE

To see how many nodes are present in your system use. Most users might only have node 1.

alive

SIN

The QNX 4 sin (system information) command can be used for many different purposes.

STARTING A PRIVATE SESSION OF PHOTON ON ANOTHER NODE

When using the Photon Graphical User Interface there is a utility called ‘phditto’ that allows users to
create private sessions of photon on remote nodes within their local area network. The user can see a
graphical representation of the desktop of that node and manipulate the GUI as if it were a local
session. This option is especially helpful when used for technical support or to remotely start
programs because the computer running the session can visually see the desktop and programs
running on the remote node. This also allows computers with limited or exhausted CPU utilization
or memory to use a remote computers resources.

To start phditto on another node.

1. In a QNX shell (pterm window), type phditto -n//2/dev/ph+ and in this case, phditto will
start a photon session on node 2 because of the -n argument and the node specifier. 

2. This command will prompt you for a login information before you access the computer.
3. If you wish to join a session already started on a remote node type phditto -n2 and a window

will launch with the remote photon session in it. This session is not private!  View and Control
are shared by the remote terminal as well as the node in question. This is very useful when two
parties are looking to collaborate on a project or show information to individuals remotely. 

Phditto is a useful tool which also allows the use of an ip address as a location specifier, a modem as a
medium of transport and a number of other features out of the scope of this help file. If you wish to
learn more about the use of phditto we suggest the Photon Help files or type use phditto at the

sin command purpose

use sin gives the usage for sin

sin gives you the names of the applications running (ps in UNIX)

sin in show your node number and other information

sin ver shows version of applications running
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command prompt for a more complete list of features.

STARTING M300 ON/FROM ANOTHER NODE

To start M300 on another node.

1. In a QNX shell (pterm window), type on -n4 M300 at the command prompt. In this case, the
M300 software will begin on node 4 as specified by the ‘-n4’ argument.

2. Verify that the M300 software has started on node 4.
To start M300 from another node.

1. In a QNX shell (pterm window), type on -f4 M300 at the command prompt. In this case, the
M300 software will begin on your node after node 4 has loaded it as specified by the ‘-f4’
argument.

2. Verify that the M300 software has started your node.

To run M300 displays on another node using the display(s) on the remote node.

1. In a QNX shell (pterm window), type M300 -s //4/dev/photon at the command prompt. In
this case the M300 software will run on your node but will be displayed on node 4 as specified by
the ‘//4’ portion of the photon device path.

2. Verify the displays are present on node 4.

Note: When using any of the above commands to run or display the M300 on another node, the M300
software will not run unless the appropriate security files (with the correct codes) have been created on that
particular node.

AUTOMATICALLY START THE M300 ON SYSTEM BOOT

To start the M300 system automatically.

1. Create a new user in the ‘sea’ group with no password to allow your system to perform auto login.
You can do this by opening a shell and becoming super ‘su -’ and press enter, followed by the
password for the root user.

2. Next you must type the password command and then the name of the user you wish to create.
Make sure you look at ‘/etc/passwd’ file and look at the existing user ids. New user id, must be
greater than 101 and not any of the existing user ids. For our purposes we suggest the user name
‘operator’ because it is easily identifiable. You would accomplish this by entering ‘passwd
operator’ at the command prompt. 

3. Next you will be prompted for the User account information. The following is a list of
recommended responses to these prompts. For more detailed information as to how these
decisions were made please refer to (See “Adding User Accounts”  on page 37).
User ID: 110
Group ID: 101
Real Name: operator
Home Directory: /home/operator
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Login Shell: /bin/sh
New Password: Press ENTER
Retype New Password: Press ENTER

4. Copy all necessary files from a previously existing user to the new ‘operator’ user. This will
transfer system settings and preferences. For example, type ‘cp -pR /home/augie /home/
operator’ at the command prompt. This is a critical step, without the ‘.sea’ directory and other
files, the user account will not work as necessary.

5. Edit the sysinit file located in the ‘/etc/config’ directory and modify the ‘tinit’ line at the end of
the file.

automap -X -d1000 -D1000 &
sleep 1
/sea/bin/security &
tinit -T /dev/con* -c “login operator” -t /dev/con1 &

6. Edit the ‘phapps’ file in the /home/operator/.photon directory by adding ‘M300 -af &’ to the
end of the file to start the M300. If you also want to start another application, for example
SeaWcm utility, then add also a line before the M300 line such as, ‘SeaWcm -auto &’. Comment
out or delete any other programs that are started in this file (for example pterm windows). If you
do not delete or comment these lines out the M300 will not automatically run.

7. Edit the ‘.profile’ file in the ‘/home/operator’ directory by adding ‘ph’ to the file. This command
calls the photon GUI with ‘ph’, then this line executes the command.

LAPTOP SYSTEMS FOR M300

It is possible to setup laptop systems running M300, QNX 4 and Photon 1.14. If you have the need
for a laptop system for M300 usage please contact SEA.

FILENAME RECOMMENDATIONS

Please use ‘*.sea' for SEA M300 binary raw files. Also adhere to all other conventions for M300
project file extensions.

USING MULTIPLE PARTITIONS (MULTI‐BOOT)

If there are other partitions on the system from a DOS/Window environment, you can run the
Fatfsys driver to get access to these under ‘/dos/c’, ‘/dos/a’, etc. Please check the documentation for
the Fatfsys utility under the QNX 4 manual.

TCP VS. UDP

TCP is short for Transmission Control Protocol. UDP is short for User Datagram Protocol. Both of
these allow data to flow over IP networks. There are some basic principals the M300 user must be
aware of since these can be used for data acquisition and transmission.
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These protocol used port number (aka sockets) or port names that are defined in the /etc/services
files.

TCP is one to one, reliable protocol, slower, harder to setup.

UDP is one to many, un-reliable protocol, faster, easy to setup.

For the most part UDP does a great job. The packet loss is minimal the way we typically setup our
systems. Only one system can send UDP data on network ports (aka sockets). Many systems are able
to listen to this data.

QNX SETUP FOR M300 UDP OPERATIONS

UDP is the TCP/IP User-Datagram Protocol. It is a connection less protocol requiring very little
overhead. The following QNX setup must be done prior to using the M300 for broadcasting UDP
data. Note that all machines planning to use UDP for the M300 need to have the following
configuration.

1. Modify the ‘/etc/services’ file to include the following at the bottom, just below the “QNX
Services” entries.

#
# SEA
#
sea-udp     2001/udp
radar-udp   2000/udp

2. Next, modify the ‘/etc/netstart’ file to include the following line that is in bold.

export SOCK=$NODE
/bin/slay -f Tcpip;
/bin/prefix -D /dev/console >/dev/null 2>&1;
/bin/prefix -A /dev/console=/dev/con1;

/usr/ucb/Tcpip qnx &

/usr/ucb/ifconfig en1 192.9.200.2 up
/usr/ucb/ifconfig lo0 localhost up
/usr/ucb/ifconfig en1 broadcast 192.9.200.255
#usr/ucb/route add 224.0.0.0 192.9.200.2
#usr/ucb/route add 225.0.0.0 192.9.200.2
/usr/ucb/route add default 192.9.200.40
#/usr/bin/syslogd

# Note: to act as an NFS server, uncomment the next line
# /etc/nfsstart

# Note: to act as a TCP/IP server, uncomment the next line
/usr/ucb/inetd &
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3. To begin the UDP services, you must run the ‘netstart’ batch file. This can be done at the
command prompt, or by inserting the following line into the ‘/etc/config/sysinit’ file and
restarting.

netstart

4. You can use netinfo -l to see information about the network card. Both the receive and
transmit sides should have a value for number of total packets. If these are 0, then this would be a
problem.

5. To ensure proper operation of the network for UDP transfer, make sure two QNX machines can
communicate by using the ‘ping’ command. In the M300 QNX system, at the command prompt
(either in a shell or from the main command prompt), perform a ping command by typing ping
ipAddress where ‘ipAddress’ is the IP address of the other QNX machine. The ping should run
without any errors. Hit Ctrl+C to terminate the network ping program.

PERFORMING DIRECT DATA TRANSFER FROM QNX TO WINDOWS (FTP)

To set up the M300 to transfer data directly to Windows, use the following steps to perform the
initial configuration.

1. Connect the two computers with regular network cables through a network hub or using a
standard crossover cable (for direct connection).. 

2. Determine the IP address for the Windows machine. To do this, right click on the network icon
and then select properties, or use the control panel Network Settings. In Windows XP, after
selecting properties, you must then select the appropriate network connection. 

3. Select the TCP/IP client and check the IP address and the associated mask. The mask is usually
something like 255.255.255.0. If you make any changes to the windows machine, you must
reboot. Write down the IP address.

4. In the M300 machine, edit (as root) the ‘/etc/netstart’ file and assign an IP address different than
the Windows machine, but in the same subnet. For example, if the Windows machine IP address
is 192.9.200.20, you could assign 192.9.200.30 (only change the last number) for the M300
QNX system. The 192.9.200 is the subnet. The following is a sample of the ‘netstart’ file. The
line in bold is the line that contains the IP address of the M300 QNX machine.

export SOCK=$NODE
/bin/slay -f Tcpip;
/bin/prefix -D /dev/console>/dev/null2>&1;
/bin/prefix -A /dev/console=/dev/con1;
/usr/ucb/Tcpip qnx &
/usr/ucb/ifconfig en1 192.9.200.1 up
/usr/ucb/ifconfig lo0 localhost up
/usr/ucb/ifconfig en1 broadcast 192.9.200.255
#/usr/ucb/route add 224.0.0.0 192.9.200.2
#/usr/ucb/route add 225.0.0.0 192.9.200.2
/usr/ucb/route add default 192.9.200.40
#/usr/bin/syslogd
#Note: to act as an NFS server, uncomment next line
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#/etc/nfsstart
#Note: to act as a TCP/IP server, uncomment next line
/usr/ucb/inetd &

5. Run ‘netstart’ in the M300 QNX machine.
6. Use the ‘ping’ command to check for a good connection. From the Windows machine, use the

Start menu and then click on ‘Run’. At the prompt, type ping ipAddress where ‘ipAddress’ is
the IP address assigned to the M300 QNX machine (in our example it was 192.9.200.30). The
ping should return with no errors.

7. In the M300 QNX system, at the command prompt (either in a shell or from the main
command prompt), perform a ping command on the Windows machine, again by typing ping
ipAddress where ‘ipAddress’ is the IP address of the Windows machine (on our example it was
192.9.200.20). Again, the ping should run without any errors. Hit Ctrl+C to terminate the
network ping program.

8. Now that you have the two machines communicating, use an FTP program in Windows to
transfer data to and from the M300 QNX machine. You must, however, use a regular username
and password when logging into the M300 QNX machine. The system is not configured to allow
root access via FTP for security reasons.

CREATING ASCII DATA FILES

Aside from the main M300 raw binary data file, the system can also create text files (ASCII). These
text files can be imported by most analysis software applications. The text files can have any data
values from the formula table. The user controls the delimiter and line termination.
The ASCII File Output table is ‘asc.300’. This file can be used to specify one or more entries of
ASCII data output. Each entry has an ASCII configuration file (*.asc), which the user must create,
and an output text file name (*.csv). The ASCII configuration file indicates which data to output, in
what order, etc. The output text file has the actual data and this file is created by the system. Every
time the system starts this text file is overwritten. The user must copy this file before or after the
system runs to a different file name. Please consult the ASCII File Output Table documentation in
the reference manual for complete information on this topic.

SERIAL PORT BASICS

The QNX 4 system supports multiple serial ports through an additional hardware board. Some
boards use the standard ‘Dev.ser’ driver, others have their own driver. In either case the first serial
port is called ‘/dev/ser1', ‘/dev/ser2’, etc. You can use the ‘serread’ utility to read/send data using any
of the serial ports (check SEA Utilities manual). To change the serial port parameters use the ‘stty’
utility (check the QNX 4 manual).
We disable com2 in the M300 systems. This is necessary because this port uses IRQ 3, which causes
a conflict with the SEA System board. IRQ 3 is used as the acquisition handler tick source. By
default, this interrupt has the highest priority of all interrupts.
You can also use the ‘cat’ utility to get/send data to/from the serial port using the redirect ‘>’ or ‘<‘.
Usually the M300 security key uses /dev/ser1 for the key. No other devices can use this port. If they
do, they will crash the security and terminate any open M300 applications using the security.
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The best way to test a serial port is to do this with the ‘sertest’ utility. Please see the ‘sertest’ utility in
the SEA Utilities User’s Guide for more information.

All serial ports must be tested to make sure they are working and communicating properly. For
simple testing the user can use ‘serread’ to see data on a particular port. To transmit test data on a
serial port use the ‘simser’ utility.

SENDING ASCII DATA OUT THROUGH THE SERIAL OR PARALLEL PORT

In the same way that the system can create ASCII output files using the ASCII File Output (asc.300,
*.asc), it can also output to the serial or parallel ports. The only difference in this case would be that
the user would have to specify the port name as opposed to a data file name. For example, to output
to the serial port use /dev/ser2 or to the parallel port use /dev/par1.

RUNNING IN THE BACKGROUND

One of the features of QNX is the ability to execute a command/application in the background from
a shell in Photon. Do the following to run in the background.

1. In a QNX shell, type executable &, where ‘executable’ is the command/application to be run.
For example, to run RawView from a pterm window (shell), type Rawview &

SOFTWARE UPGRADES

SEA can send out software upgrades to a client via e-mail, ftp or the web site when necessary
assuming the client has a valid technical support plan for the M300 system. Here are some points to
remember about the software updates:

• When the user gets the software upgrade there are a number of basic steps to get the software installed.

• Before you start, backup the ‘/sea/bin’ directory so that you can always go to the previous version if desired.

• Usually the file you get is compressed. So the first step should be to un-compress the file.

• The file may have been created with the ‘tar’ utility. If so, you should use the ‘tar’ utility to extract the files 
out.

• Finally, the software files should be copied to the ‘/sea/bin’ directory. This directory has all the SEA software 
files and it has been added to the PATH. In this was any executable in the ‘/sea/bin’ directory can be 
executed from anywhere.

• We have created the SoftTool utility to simplify the software updates. Please check the documentation for 
the SoftTool utility in the Utilities User’s Guide.

Note: After this, it is recommended that you run the software and check the version from the about dialog
in the help menu of the M300 software. Make sure you have the new version as opposed to your old one.
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CAPTURE/PRINTING M300 WINDOWS

The M300 system has the capability to print data to a file (bitmap, *.bmp) or directly to the printer.
You should consult the Photon manual for help with setting up and configuring the printer.
Normally you can use the print button from any M300 window to get the print dialog. In addition
to this there is a photon utility called ‘snapshot’, which you can use to print/capture a window or the
entire screen. Please check the Photon documentation for this utility (See “Getting Help for QNX 4
and Photon”  on page 31).

M300 SCRIPTS

The following are the scripts for M300 system operation and management. They are executed the
same way as any other executable file.

casr - Copies as root, an SEA script/executable to the ‘/sea/bin’ directory. For example, to copy the 
M300 executable, type casr M300 at the command prompt.

m300k - Kills all existing M300 processes. Usually this script is not needed unless there is a prob-
lem with the M300 closing properly.

rasr - Runs a file as root. To execute, type at rasr file the command prompt, where ‘file’ is the 
file to be run as root user.

sc - Sets the screen color according to the ‘background’ and ‘foreground’ colors specified. For ex-
ample, to set the background to white and the foreground to blue, type sc blue white at the com-
mand prompt.

text - restarts the QNX text video mode driver. If after exiting photon the video driver fails to go 
back into text mode, type text at the command prompt. Note that you will not see the text echo to 
the screen because the video driver has not yet started.

MAKING SCRIPTS

Scripts are like batch files in the DOS system. You can group a set of commands in a file and then
make the file executable. Check the QNX 4 documentation for ‘chmod’, ‘chgrp’ and ‘chown’.

To make the ‘file’ executable by all users do the following.

1. In the directory where the script file is stored type chmod a+x file where ‘file’ is the name of
the script file.

2. Type ls -a at the command prompt. The script file should now have an asterisk ‘*’ appended to
it. This indicates that it is now an executable file.

COMPRESSING/DECOMPRESSING FILES (THE ‘GZIP’/’UNZIP’ UTILITIES)

To compress files.
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1. In a QNX shell type gzip filename where ‘filename’ is the file you wish to compress. For
example, gzip seam300.tar will compress the file ‘seam300.tar’.

2. Type ls -a. The compressed file should have the extension ‘.gz’ appended to the end of it.

To decompress files.

1. In a QNX shell, type gunzip filename where ‘filename’ is the file you wish to compress. For
example, gunzip seam300.tar.gz will decompress the file ‘seam300.tar.gz’.

2. Type ls -a. The compressed file should have the extension ‘.gz’ removed from the end of it.

To compress a file (for example, 120101.sea) keeping the original file, use gzip -c 120101.sea
>120101.sea.gz

Note: For further details on using the gzip/gunzip utilities, refer to the QNX 4 documentation (See “Getting
Help for QNX 4 and Photon”  on page 31).

GROUPING/UNGROUPING FILES (THE ‘TAR’ UTILITY)

To group a set of files, in order to keep files permissions.

1. In the directory containing the files you wish to group, type tar -cvf tarfile.tar
filenames where ‘tarfile.tar’ is the filename of the tar file to be created and ‘filenames’ are the
filenames, one after the other separated by a space, of the files that are to be grouped into
‘tarfile.tar’. For example, tar -cvf seam300.tar *  Note that this example will create a tar file
called ‘seam300.tar’ and the ‘*’ in the command sentence instructs QNX to use all of the files in
that particular directory.

2. Type ls -a to verify that the tar file has been created.

To group all files in the current directory excluding ‘*.sea’ files use:

1. In the directory containing the files you wish to group, type find ! -name ‘*.sea’ -type f
| xargs tar -cvf tarfile.tar where ‘tarfile.tar’ is the filename of the tar file to be created.

2. Type ls -a to verify that the tar file has been created.

To un-group a set of files.

1. In the directory where you wish the files to be ungrouped, type tar -xvf tarfile.tar where
‘tarfile.tar’ is the filename of the tar file to be ungrouped. For example, tar -xvf seam300.tar
Note that this example will ungroup the file ‘seam300.tar’ into the current directory.

2. Type ls -a to verify that the tar files have been ungrouped.

Note: For further details on using the tar utility, refer to the QNX 4 documentation (See “Getting Help for
QNX 4 and Photon”  on page 31).
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FIND FILES

There are times when it’s necessary to look for a certain group of files or a particular file name. The
utility we use for this is called ‘find’. For more information do use find or check the Helpviewer
documentation for the find utility. Here are some simple and common examples of how to use the
find.

1. To search for all ‘wnd.300’ files from the root, use cd / and then find -name ‘wnd.300’
2. To look for a specific file, for example ‘rocky.tgt’, use cd / and then find -name

‘rocky.tgt’
3. To search for all files in the current directory, excluding all ‘*.sea’ files, use find ! -name

‘*.sea’ -type f

At times we want to search for a particular string/text in a file. For example, we could search all
‘acq.300’ files for the word ‘Analog0’. Here are the commands for this.
cd /
find -name ‘acq.300’ | xargs grep Analog0

STORING YOUR DATA AT THE FINAL DESTINATION, SEPARATE FROM THE M300

Once you create your data files you will surely want to take them to another system. There are several
ways this can be accomplished.

Note: User must be logged in as superuser to mount any drives in the qnx operating system.

USING FTP (FILE TRANSFER PROTOCOL)

You can login to the M300 DAS over the Network using FTP and transfer any files to a remote
client. If you wish to run FTP you must start ‘netstart’ first. This is a script located in the ‘/etc’
directory. You need to edit this script and enter the correct IP address for your system. Then run
‘netstart’ again to restart the TCP/IP driver with the new IP address.
If you are having problems connecting to other systems use the ‘ping’ utility. Please check the TCP/
IP manual for this (See “Getting Help for QNX 4 and Photon”  on page 31).

USING THE USB DRIVES

There are two different ways you can access the USB drives. Using the native QNX 4 file system or
the DOS/Window FAT. You would use the QNX 4 file system formatted drives to back and store
files and projects from the M300 system. The FAT formatted drives would only be used to transfer
files to/from DOS/Windows systems. Here are some basics to help you get started with this.

Using the USB drive in the QNX File system.

1. Insert USB drive. These steps assume we are only using one drive and it’s the only one mounted.
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2. Use the seadrive -qnx to mount the ‘/hd1’ directory, which is the mount point to for the USB
drive.

3. Copy the files.
4. Before removing the USB drive, use seadrive -qnx to un-mount the drive.
5. Remove USB drive.

Using a USB drive with a Windows FAT.

1. Insert USB drive. These steps assume we are only using one drive and it’s the only one mounted.
2. Use the seadrive to mount the ‘/dos/c’ directory, which is the mount point to for the USB

drive.
3. Copy the files.
4. Before removing the USB drive, use seadrive to un-mount the drive.
5. Remove USB drive.

USING THE CDROM/DVDROM DRIVE

There are multiple ways to access the CDROM/DVDROM drive but for your convenience our
engineers have included the mounting of the drive in the system initialization file (sysinit) located in
your /etc/config directory. The file system is not QNX or DOS but rather the cdrom standard
ISO9660. SEA configures your CDROM mount point to be /cd0 by implementing it when the
system starts using the command Iso9660fsys >/dev/null2>&1& in your sysinit file. You may
encounter problems with accessing the drive if you have previously attempted to mount the drive
manually because it has already been mounted. Restarting your system will restore the proper mount
point. To access the CDROM/DVDROM drive (DVD support required a DVDROM drive):

1. Access the drive by typing cd /cd0 in a shell.
2. Then type ls to view the contents of the CD/DVD.

TIME SYNCHRONIZATION

As far as time synchronization goes there are several aspects to consider.

• QNX 4 keeps track of time in seconds and nano seconds (since January 1st, 1970). PC clocks are not 
accurate and drift considerably over time.

• M300 also keeps track of time in seconds and nano seconds (similar to QNX 4). These are incremented in 
the IRQ 3 handler to keep track of time internally.

• System/SBUS Interface temperature controlled crystal (is highly desirable). Accuracy of 2 ppm, +/- 0.1728 
sec/day.

• System/SBUS Interface with standard crystal accuracy of 100 ppm, +/- 8.64 sec/day. Not recommended 
(use System/SBUS Interface temperature controlled crystal).

• PC Clock/QNX 4 clock typical accuracy of 30 ppm, +/- 2.592 sec/day.
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• M300 interfaces directly with BC635PCI/BC637PCI (GPS Mode) interface (IRIG-A, IRIG-B, IEEE 1344 
(Modulated or DCLS). There are no drivers to talk to the BC635PCI/BC637PCI interface in QNX 4.

• In general, time adjustments when M300 is running causes issues, mostly with data triggers. If the time 
adjustment is forward, usually it's not too bad. But if we make a backwards adjustment in time, then this 
causes problems with the triggers (specifically the time/frequency property).

• Different times used are M300 time (System/SBUS interface), QNX 4 time (PC internal clock), 
BC635PCI/BC637PCI time, NTP (network based) and GPS (either via NMEA serial data or hookup to 
BC637PCI).

Normal M300 operation.

• In acquisition initialization M300 reads either QNX 4 clock or BC635PCI/BC637PCI time. This depends 
on the mode selected in the System board setup. This is used as the starting time for M300. If BC635PCI/
BC637PCI is in fly wheeling then QNX 4 clock is used.

• In the IRQ 3 handler we increment time and keep track of time. This time (M300 time) will be different 
than QNX 4 time.

• In the IRQ 3 handler, we also read the QNX 4 time once per second.

• In the proxy, once per second, we check to see if there is a time drift between BC635PCI/BC637PCI time 
or M300 time and QNX 4 time. If the difference is less than 100 ms, we do a small adjust to the QNX 4 
clock over time. Otherwise we just set the QNX 4 clock to the BC635PCI/BC637PCI time or M300 time. 
We use BC635PCI/BC637PCI time is not in fly wheeling mode or using external clock source. Otherwise 
we use M300 time.

• If we are using BC635PCI/BC637PCI (not in fly wheeling mode or we are using external clock source). In 
the proxy, once per second, we also check to see if the M300 time and BC635PCI/BC637PCI time differ. If 
the difference is outside the time limit provided in the System Board Setup, then we reset the M300 time 
with BC635PCI/BC637PCI time.

BC635PCI/BC637PCI card interface setup (M300 board initialization).

• Setup mode (user selects mode).

• Set year using value from QNX 4 system.

• Set local offset.

• Set year auto increment.

• Set local time observe flag.

• If the time is fly wheeling mode, then we set the time to the card with QNX 4 time.

• Set the heartbeat (this uses n1 and n2 values). We compute these from maximum system frequency.

Synchronize to other systems.
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• We can synchronize to NTP server prior to running M300 (using ntpdate). While M300 is running time 
adjustments are not desirable from NTP server. The M300 Time, NTP time will drift. The QNX 4 time is 
adjusted to M300 time.

• We can synchronize to GPS NMEA data with 'timesync' utility. This again is done prior to running the 
M300. This utility takes the time from the GPS and sets the QNX 4 clock. When the M300 runs, it reads 
the QNX 4 clock, sets our own internal clock and keep trap of time with the interrupts provided by the 
System/SBUS interface. The M300 Time, GPS time will drift. The QNX 4 time is adjusted to M300 time.

• We can synchronize to BC635PCI/BC637PCI time. This is done using the BC635PCI/BC637PCI 
interfaces. M300 adjusts time based on the BC635PCI/BC637PCI time. M300 also adjusts the QNX 4 
time when using the BC635PCI/BC637PCI interface. This is the best possible scenario for time 
synchronization, assuming the BC635PCI/BC637PCI is synced.

Provide time to other systems.

• QNX 4 can run the necessary software to provide time over NTP (using xntpd). We setup our system to act 
as a NTP server. The QNX 4 time is adjusted to either BC635PCI/BC637PCI time or M300 time.

• BC635PCI/BC637PCI interface will provide time to other systems if necessary. Must have the BC635PCI/
BC637PCI interface connected to an accurate time source. Fly wheeling the BC635PCI/BC637PCI is not 
recommended, since it doesn't provide accurate time. M300 will not use BC635PCI/BC637PCI in fly 
wheeling mode unless we are connected to an external clock source.
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MAIN WINDOW AND PROPERTIES

The M300 main interface window is the primary launch point of all M300 operations. Both
Acquisition and Playback as well as UDP can be performed now from a single window. The M300
data displays can be directly managed from this window as well as formulas and almost all project
settings.

M300 MAIN WINDOW

The M300 window has been revised several times and this process will continue for as long as
changes are desired.

We will describe the M300 window feature/items from top to bottom, left to right.

If you are not quite sure which buttons are which, bring the mouse to hoover over the desired
button, while running M300 and you will get a pop text with more information.

TITLE BAR

M300
The title bar display the application name M300. The “:” separates the M300 and data source.

Data Source
The current data source is displayed in the title bar, following the M300 name. Currently the
possible valid data sources are “Acquisition”, “PlayBack”, “UDP”. If you look at the M300 title bar,
you can tell which mode you are using.
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Project Name
The current project name is display last in the M300 title bar. It is separated from the data source by
‘ - ‘. So in the M300 window above the project name was v7d1. 

M300 MENUS

The M300 menus are used to quickly and easily access a broad range of operations within the same
dialog window.

FILE MENU

New
1. In the File menu, select New (Shortcut: Alt+F, N).

Displays a create new file dialog use to create a new file to stored data.

This is used in acquisition or UDP mode to create a new data file.

WARNING: If the file already exists, the user will be asked to overwrite the existing file. Exercise caution
when overwriting files. All data for the previous file will be overwritten and can’t be recovered.

The file new dialog should be self explanatory. No documentation provided at this time.

Open
1. In the File menu, select Open (Shortcut: Alt+F, O).

Displays an open file dialog used to open a file for playback.

Note: The root directory or folder in QNX 4 is ‘/’. If the file you are trying to use is on another node, then you
must use //2/, for root directory on node 2 or //3/ on node 3 and so on.
MAIN WINDOW54



M300 USERS GUIDE  SEA
Close Write
1. In the File menu, select Close Write (Shortcut: Alt+F, W).

Closes a file being written to.

Note: The root directory or folder in QNX 4 is ‘/’. If the file you are trying to use is on another node, then you
must use //2/, for root directory on node 2 or //3/ on node 3 and so on.

WARNING: For the best record speed possible the data file must be recorded on the local hard drive (SATA is
best). If you record on USB drive or over the network, the record speed and record rate will be limited. This is
not recomended unless, tested and the data rate is not too high.

Close Read
1. In the File menu, select Close Read (Shortcut: Alt+F, R).

Closes a file being read from.

Properties
1. In the File menu, select Properties (Shortcut: Alt+F, P).

This will display the M300 file properties dialog which will facilitate modifying certain global
settings.

For a full description, (See “M300 File Properties Dialog”  on page 73).

History
Separated by a line across the menu area, this section of the file menu stores most recently referenced
files (either by opening for reading, creating/opening for writing).

This area will store the paths and names of most recently used files. To open a particular file in the
history list, simple click on it.

If the user is in acquisition or UDP mode the file is assumed to be created (write). This will require
the user to overwrite the old file.

If the user is in playback mode, the file is assumed to be open (read).

The number of files on the list is selected in (See “History Count, File, Project, Window, Command”
on page 77).

Exit
1. In the File menu, select Exit (Shortcut: Alt+F, X).

This exits the M300 system. This is similar to clicking on the close “X” button for the M300
window.

The user will be asked to save the project, if the project was saved.
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All files used by the M300 will be closed. This includes binary raw file, ASCII files, project files, etc.

EDIT MENU

Note: Currently the  Edit  menu   is not  being used.  It  has been written   into  the  M300 for  future
enhancements.

VIEW MENU

Command

1. In the View menu, select Command (Shortcut: Alt+V, C).

The command will display a command bar identical to the M300 command bar. This allows for a
small footprint to do the M300 commands, while the M300 main window is hidden.

This is still under development.

Status

1. In the View menu, select Status (Shortcut: Alt+V, S).

The status window displays information about the project.

Toolbar

1. In the View menu, select Toolbar (Shortcut: Alt+V, T).

The tool bar will display a tool bar identical to the M300 tool bar in the main M300 window.

The idea here is that the M300 window can be minimized or hidden. This tool bar would offer a
small footprint to do the control of the M300 operation.

This is still under development.
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PROJECT MENU

You can find detailed information about the projects (See “Project Management”  on page 91).

New
1. In the Project menu, select New (Shortcut: Alt+P, N).

Displays a create new project dialog used to create a new M300 project. 

Open
1. In the Project menu, select Open (Shortcut: Alt+P, O).

Displays an open project dialog.

Save
1. In the Project menu, select Save (Shortcut: Alt+P, S).

Saves the current project as it is currently configured.

Save As
1. In the Project menu, select Save As (Shortcut: Alt+P, A).

Saves the current project under a new name/directory. Note that when you save a project under a
new name, an entire directory is created with all of the files used in the original project.

Delete
1. In the Project menu, select Delete (Shortcut: Alt+P, D).

Displays a delete project dialog for project deletion.

History
Separated by a line across the menu area, this section of the project menu stores most recently
reference projects. To open a particular project in the history list, simply click on it.

The number of files on the list is selected in (See “History Count, File, Project, Window, Command”
on page 77).

SETUP MENU

The setup menu is the main point for launching most of the project setup dialogs. It is here that you
can add, delete and modify existing boards, acquisition events and buffer setups.

Board
1. In the Setup menu, select Board (Shortcut: Alt+S, B).
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All the M300 functionally as far as acquiring real time data goes through boards. The boards are the
basic entity that is present in the system.

You can find detailed information about the board setup (See “Board Setup”  on page 105).

Acquisition
1. In the Setup menu, select Acquisition (Shortcut: Alt+S, A).

The M300 provides a graphical interface for managing a projects acquisition setup. Acquisition
events can be added, removed or modified at any time from this dialog. Shows this dialog along with
it’s main features and informational display.

You can find detailed information about the acquisition setup (See “Acquisition Setup”  on
page 108).

Buffer
1. In the Setup menu, select Buffer (Shortcut: Alt+S, U).

The buffer dialog provides the user with a visual as well as a place to setup and modify buffer
management related items for the M300 system.

You can find detailed information about the buffer setup (See “Buffer Setup”  on page 112).

WINDOW MENU

The window menu is used for opening, closing, selecting, deleting and creating new display
windows. All of the functionally available in the window tab of the M300 Main window is also
available from this menu.

For information on the new window displays (See “Window Displays”  on page 165).

New
1. In the Window menu, select New (Shortcut: Alt+W, N).

Displays the new window dialog to facilitate the creation of a new data display window.

Delete
In the Window menu, select Delete (Shortcut: Alt+W, D).

Will delete the last data display window that was in focus. Note that deletion of a data display
window cannot be undone.

Previous
In the Window menu, select Previous (Shortcut: Alt+W, P).
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Selects the previous window in the window list.

Next
1. In the Window menu, select Next (Shortcut: Alt+W, E).

Selects the next window in the window list.

History
Separated by a line across the menu area, this area of the menu stores the most recently referenced
windows.

To select a particular window in the history list, simply click on it.

The number of windows on the history are defined in (See “History Count, File, Project, Window,
Command”  on page 77).

HELP MENU

About the Model 300
1. In the Help menu, select About Model 300 (Shortcut: Alt+H, A).

This will display the about dialog. This dialog contains the current M300 version (including date of
compile), the registered client, the system serial number.

TOOL BAR

Acquisition (ACQ)
The user can select the source of the data for the M300 system to use. These are mutually exclusive
per M300 session. It’s not possible to have the same M300 window use Acquisition and Playback
simultaneously.

When running multiple sessions/instances of the M300 system, only the first one is allowed in
Acquisition mode.

This will put the M300 into acquisition mode which will then enable the user to acquire, record,
display real-time data from board/acquisition sources.

The M300 must record data for the user to be able to playback the data.

Playback (PB)
This will playback M300 or M200 binary files. ASCII files CANNOT be used for playback.
Typically a user will select playback and then open a file associated with the current project to
playback data taken from a previous time. These files are raw, binary ‘*.sea’ files.
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UDP
User Datagram Protocol. This will enable the M300 UDP receive mode. When an M300
workstation is in either acquisition or playback mode and broadcasts data (see below “Broadcast
Mode”), other workstations can use UDP to receive that data, provided the UDP port is configured
properly in the general properties.

Data transferred of the UDP protocol is not reliable. So not all UDP records transmitted from the
server can be received by the client.

UDP data can be recorded, just as real-time acquisition data. Again, the user must know that not all
data is received and hence recorded.

Pause
Pauses the M300 system so no new data is display. This can be used in Acquisition, Playback and
UDP.

If you click the pause again, the M300 will continue with the data gathering.

This is a global pause for all M300 windows. Each individual window is also equipped with a pause
button which allows to user to pause one window at a time.

Stop
Stops the M300 system. Once you click stop, no time advance on any of the windows.

Play
Starts the M300 system. Once you click start, you should see time increment for all project windows.

Rewind 
Places file pointer to beginning of file (will reset file progress bar as well). This is only valid for
playback mode.

End
Places the file pointer at the end of the file. Only valid in playback mode.

Next Buffer
Will only read one M300 buffer at time and then will wait for action from the user. Only valid in
playback mode.

Record Toggle
Turns record mode on (depressed) or off. Record mode may be enabled even if there is no file open
for writing.

Broadcast Toggle
This places the M300 into UDP broadcast mode. Broadcast mode will begin sending all M300
binary raw data over the network. The M300 broadcasts the same information that is recorded in the
raw binary file.
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Formula Watch and Alter
This button brings up a formula watch window. This allows a user to see what is happening with any
particular formula and its corresponding results. More than one formula watch window can be open
at any given time. They are considered part of the current project and all of them will be saved or
restored when the M300 start/stops.

ASCII Record
Toggle ASCII recording on (depressed) or off.

When in playback mode, there are times when the user might not care about the recorded data, they
just want to playback the data as fast as possible. Without writing to the ASCII files, it will speed up
the playback considerably.

Display Windows
Toggle display windows open (depressed) or closed. The M300 saves the state of this button. If it
looks like all your displays/project windows are gone, just check the display window button.

During playback, if the user just wants to generate the ASCII files they can turn off all the display
and the M300 will generate the ASCII data faster since it doesn’t have any displays to work on.

Window Lock
Toggle global window lock (depressed) or un-lock. For any of the M300 display windows with lock
properties set, this will lock the windows so the user can’t change the selected properties. This is
usually desired when on a project and it’s not desirable to have the system operator make changes to
the project.

Each individual window for the M300 also has a lock button which can be used to lock only one
display at a time.

In order for the displays to lock the user must set the lock flags (See “Flags Tab”  on page 173).

Window Scheme
Toggle window scheme secondary, ‘Swnd’, (depressed) or primary, ‘Pwnd’. The M300 keeps track of
two window positions for all display windows in the project. This allows the user to change between
two different display configurations rapidly.

This is useful as well if you need to run the same project on several machines with different screen
resolutions supported, such as M300 system and laptop.

COMMAND BAR

The M300 system allows users to enter commands into the system. These some times can be entered
into the cmd.300 file and have a function key assigned to them for convenience. Additionally we give
the user a way to enter commands manually.
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Command
To the right of the ‘>’ command prompt is command drop down box. The user can type any
commands to be executed by the M300 system. The commands are stored in the drop down list.
Most recent at the top.

The number of commands in the history is selected in (See “History Count, File, Project, Window,
Command”  on page 77).

Once the command is typed and ready to be executed, the user must hit the “enter” key.

If the M300 is in acquisition mode and the data is being acquired all commands are stored in the
command buffer, under the reserved command tag.

The M300 will “store” all commands valid or not. If the user wants to type some comments to be
saved in the raw binary data, he can do so in the command window.

Select and Execute
Toggle select and execute. When this button is pressed, any command selected from the list is
immediately executed by the M300.

This doesn’t allow the M300 to make any changes to the command before they are executed.
Some times it is necessary to type similar commands as the ones in the history. This allows the user to
pick a command and make modifications before they are executed by the M300.

Execute and Clear
Toggle execute and clear. If this button is pressed after the command is executed, the command
prompt will be cleared. This allows the user to type a new command without having to delete/modify
the command line.

If the execute and clear is not depressed, then the command line will not be cleared after the
command is executed. This allows the user to use the current command to make modifications.

M300 TABS

These provide a convenient way to switch between different types of M300 information and
controls. They provide access to the status, acquisition, playback, window, project and usage panels.
See the description for the data in each of the tabs in the next few sections.

STATUS ERROR MESSAGE

This line of text provides a quick look to the last error message generated by the M300. It is viewable
regardless of which display tab is visible.

The M300Logger has all error messages. The M300 status error message allow the user a quick pick
at the last error message.
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For the most part error messages are bad. The user must track down the source of all error messages
and eliminate them before running and acquiring data from a project.

Unless the user knows a particular error message and they are sure it is benign, they shouldn’t ignore
error messages.

STATUS BAR

The status bar has information about the project as well as current time and date.

Project Name and Flight Id
Provides a quick look at the current project name and flight id, that is entered in the project display
tab. Not that the project name displayed here is not related in any programmatic way to the project
folder or configuration files. It is for user-defined purposes only.

Buffer Time and Date
The buffer time and date display current time and date from M300 data source.

If the M300 is in play mode and new data is arriving the time should be incrementing. If the system
is stopped or paused, the time will not increment.

The time is the end time from the sync 1 hz buffer. In acquisition mode this would increment once
per second (1 hz). In playback mode the time might increment slower or faster than one 1 hz,
depending on the playback speed setting.

All the M300 display windows have time and date display in the top left corner. The time displayed
there some times can vary from the M300 main window, depending on the particular trigger used for
the display windows.
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STATUS TAB

The status tab display information about M300 data size, rates, state, duration, maximum duration,
errors and file names.

Note: The status tab is the default tab the M300 uses on start up.

System Row
The total column has different meaning for acquisition, playback and UDP. During acquisition/
UDP, it will display the total bytes acquired/read. During playback, the total file size will be
displayed.

Rate shows the data rate.

Position is only valid for playback mode. It show the position into the file.

Error is valid only in acquisition mode. It shows the number of times the sync buffer was busy. This
should always read 0. Any other values and the user needs to look at the acquisition process to see
where the cause for this error is. Not enough buffer or spending too long in acquisition mode.

Record Row
The total column displays how much data is being recorded to a file and the current rate it is being
recorded at.

The record state shows off in red color (no storage), on in black color (record on, but no file to write
to) and on in green color (system is happy recording to a file).

The current time in ms that the M300 record (m300r) is using, followed by average time and
maximum time.

The last column shows any errors from the M300 record. It should be zero. Any errors here and the
user needs to investigate the cause of the record errors.
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This is valid only for acquisition and UDP modes.

Broadcast
The total column displays how much data is being broadcast to other systems. This is followed by the
broadcast rate.

The broadcast state is off (red) or on (green). This indicates whether the broadcast is on or not.

The current time in ms that the M300 broadcast (m300b) is using, followed by the average time and
maximum time.

The last column shows any error from the M300 broadcast. It should be zero. Any errors here and
the user needs to investigate the cause of the broadcast errors.

This is valid only when broadcast toggle is depressed, while broadcasting data.

Write To
This field holds the path and filename of the file being written to when the record button is selected.

This is used for acquisition and UDP modes.

Read From
Displays the path and filename of the file being read from during playback.

This is used for playback mode.

ACQUISITION TAB

The acquisition tab displays information pertinent to acquisition mode for the most part. During
playback and UDP modes, the acquisition tab displays only frequency information.
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The information for the IRQ and Proxy times are from the counters on the system board. When we
do acquisition using the PC clock as a time source for acquisition, we assume there is no system
board present. So all values pertaining to IRQ and Proxy would be zero.

The basic information displayed here is the times for IRQ handler and times for Proxy handler.

At the user selected frequency from the system board table, the M300 generates an interrupts for
acquisition (IRQ 3). This is the engine for the acquisition process.

While in the IRQ handler the OS can’t schedule other tasks. To stay real-time, we must keep the
time in the IRQ handler as short as possible. So we kick a Proxy to handle the acquisition work.

All the acquisition work is done in the Proxy handler.

So we display latency and duration here for both IRQ and Proxy. We display current value,
minimum values, maximum values for all these.

IRQ Latency
The IRQ interrupt latency is the time from the assertion of a hardware interrupt to the start of the
interrupt handler.

IRQ Duration
This is the amount of time it took to process the last interrupt.

Proxy Latency
The Proxy latency is the time from the end of the interrupt handler to the start of the Proxy handler.

Proxy Duration
This is the amount of time it took to process the Proxy handler. Since we do all the acquisition in the
Proxy, this is the time it took to do all the acquisition.

IRQ Error
The M300 system can determine giving the timing information for system frequency, IRQ and
Proxy if there are errors associated with the IRQ.

This field must be 0 during acquisition. Any errors here and the user must investigate the source of
the errors. High frequency value, many acquisition events, spending too much time on displays can
be the cause of these problems.

Proxy Error
The M300 system can determine giving the timing information for system frequency, IRQ and
Proxy if there are errors associated with the Proxy.

This field must be 0 during acquisition. Any errors here and the user must investigate the source of
the errors. High frequency value, many acquisition events, spending too much time on displays can
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be the cause of these problems.

Frequency (hz)
This is the system frequency. This value is the value the M300 system board uses to generate
interrupts.

Monitor (hz)
The monitor is used to check if the system frequency actually matches the requested frequency.

The number of interrupts must match the system frequency, otherwise this is an serious issue.

The system shows current value, minimum value and maximum values for monitor (frequency).

Monitor Error
The monitor error keeps track of the number of times that the system frequency didn’t produce the
requested number of interrupts.

The monitor error must be 0. Otherwise the user must determine the cause of these error. Most
likely issues could be trouble with acquisition and buffer setup. Possibly hardware issues on the
system board. Also, invalid setup causing interrupt issues.

BC Card (s)
When using the BC635/BC637 modes for time synchronization to IRIG-B source, this field shows
the difference in seconds between M300 time and IRIG-B time on the card.

The BC635/BC637 is configured in the system board setup dialog.

BC Card Adjust Count
When using the BC635/BC637 modes for time synchronization to IRIG-B source, this field shows
the number of times the M300 time was adjusted to the IRIG-B time.

We usually use a 1 ms time difference allowed between clocks. This should not cause the time adjust
to increment too often. If we count once per hour or so, is a good adjustment count.

The BC635/BC637 is configured in the system board setup dialog.
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PLAYBACK TAB

The playback tab displays some information about data being played back on the M300. Here the
user can change the speed of playback and jump to any point within the data being played back, as
well as get a snapshot of how far into the file the M300 is.

Note: The playback tab is only applicable while the system is in playback mode. During acquisition and UDP,
the M300 disables the controls inside the playback tab.

Playback Period
Controls the speed at which M300 handles data for the playback mode.

During playback, the M300 will attempt to read a buffer, place this buffer in shared memory and
inform all workers that a buffer is ready to be worked on. The playback period/frequency controls
how fast the worker is called. The worker reading the data will not generate an M300 buffer per each
time it’s called. Basically, the user has control on how fast to playback.

If the user picks 1 ms playback period, this sets the M300 worker responsible for reading the data to
do it as fast as possible.

The playback period is converted into a playback frequency. A playback of 0.002 s, results 500 hz
frequency. A playback of 2 s, results in 0.5 hz.

Dragging the side bar to the left and right has the same effect as changing the playback period.

The M300 remembers the playback speed on exit. If you are trying to playback data and it seems
slow, just check the playback period on the playback tab.

File Scroll Bar
Controls where in the file the file pointer is currently at. Clicking and dragging the scroll bar allows
the user to select which section of the data file to playback.
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File Progress Bar
Displays how far along the file pointer is (in percentage).

When the user rewinds, goes to end of file, uses scroll bar to change the position, this will also change
the file progress bar.

WINDOW TAB

The window tab is the main focal point to control data display management operations. The user can
create a new display or delete an existing display from this tab.

New Window
Brings up the create new window dialog. The gives the user the means to create a new window.

Delete Window
Deletes the current window selected by the drop down menu. When you delete a window, it is
permanently deleted from a project and cannot be recovered as it gets deleted from the main window
list.

There is no undo feature in the M300, so the user can get around this by exiting the M300 and not
saving the project. When the M300 is restarted the original project settings will be as before,
unchanged.

The corresponding *.wnd file is not deleted and thus can be added after deletion only by editing the
wnd.300 (main window configuration file) file and adding the deleted entry back into this file. See
the M300 Reference Guide for more information regarding the formats of these files.

If the window is not going to be used again, the user must manually remove the corresponding
window file to avoid confusion.

Previous/Next
Cycles to the previous or next window respectively.
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Alphabetical Order
This allows the user to reverse the alphabetical sort order for the windows in the drop down display
list. If button is depressed, the order is reversed.

Window Type
If the user has a large list of windows, and they are only looking for a particular window type, then it
can be filtered here. For example, if the user is looking for a strip chart window, then they can pick
‘stp’ from the window type filter. When they look at the drop down list, only strip chart windows are
displayed.

Drop Down Select List
Lists all of the current data display windows. This allows you to quickly select a window and bring it
to the front. If the window is in another Photon console, the console will be switched to bring the
window in view.

As explained above, the user can select all or some of the windows to look at in the drop down list.

Name
The name text box displays the name of the current window. It also allows the user to change the
name of the window to a new name if desired.

When the user changes the window name, the corresponding displays are switched to the new name.
For example, if there was a text ‘txt’ window named ‘main’ and it was changed to ‘maintxt’, then all
the entries in the txt.300 file would be changed to use the new window name.

Window names/numbers must be unique.

PROJECT TAB

The project tab allows the user to enter and display information about the project. The information
entered will be subsequently written into any new acquisition files created. Also, the project
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information entered here is saved in the prj.300 configuration file in the project folder

During playback the project information will automatically be displayed into these fields.

The data in these fields can only be changed while stopped, otherwise the change is not permitted.

Project Name
The name of the project. This can have spaces and is displayed at the bottom of the M300 window.

Flight Id
Flight id to keep track of the number of missions and be able to identify them. This can have spaces
and is also displayed at the bottom of the M300 window.

Operator Name
The operator name.

Aircraft Type
Aircraft type, if applicable used for the project.

Aircraft id
Aircraft id, if applicable used for the project.

Comments
A general purpose comment field to save any desired additional information.

Data Prefix
The data prefix to use in the auto M300 file creation. When there are multiple aircraft in the
projects, this allows to have a different auto name creation for the data files.
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USAGE TAB

The Usage Display Tab is a convenient tool to continually monitor critical resources that can effect
M300 DAS performance. This information has been integrated into the M300 main console to make
that information easily available even during in flight data acquisition. The two resources monitored
are System Memory (RAM) and available Hard Disk Space (Disk).

After each time the M300 is used to collect data it’s recommend to copy the data to another source
(USB drive). Also, the user must check the integrity of the data via playback. If the disk space is
getting low, the user must remove some with caution! Any files removed in the QNX 4 OS can’t be
un-deleted! The user must make sure there is sufficient space for the M300 to run and collect all
necessary data (*.sea and ASCII files).

The three key statistics reported on the System Ram and Disk Space are total available capacity of the
resource, total resource used, and free or available resource. All information is represented in
Megabytes and is displayed both numerically and in graph form for a quick assessment of resources.

Total
The total amount of resource (RAM or DISK size) installed in the system.

Used
The amount of system wide resource (RAM or DISK space) currently in use.

Free
The amount of system wide resource (RAM or DISK space) available to any resource.

Graphical Bar
Provides a quick snapshot of the current status of the resource. When the resource becomes 95%
used, it will change from green to yellow, and then to red at 98%.
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M300 FILE PROPERTIES DIALOG

The M300 file properties dialogs has sections for files, general and print settings.

FILES TAB

Automatically turn record on/off for ASCII text files with record button
This option allows the user control over the ASCII record state based on the M300 record state.

Save project setup tables at start of raw binary file
Typically the user will have this option check to save the M300 project files at the start of the M300
binary file.

Note: This allows getting the M300 project files from the raw data with the SeaTool. See the SEA QNX 4
Utilities in the SEA Photon Utilities section, SeaTool. http://www.scieng.com/pdf/SeaUtils.pdf

This allows getting the M300 project files from the raw data with the SeaTool.

On occasion this can be turned off, if the user wants to create a file without the M300 projects.

Show all files open warnings
This is a debug option which must be turned off for most of the time. If necessary SEA will instruct
to turn on this option for debug feature with project files related issues.

Sync
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When the QNX OS writes to a file, it doesn’t update the directory structure. This is done to
maximize the write speed. The result is after a crash/power loss the contents of the files will be lost.

The OS provides a function that can be called to update the directory structure. The name of the
function is sync.

So this allows the user to select how often in seconds the sync function is performed. Typically the
sync function is done once every 60 seconds. This means at most the user might lose 1 minute worth
of data.

If the sync is done very often it will slow down the write and the data rate that the M300 can do.

The sync time works with the M300 raw binary files and also the ASCII files.

Auto File Name, Year, Month, Day, Hour, Minute and Second
When using the generate file name feature of the M300 for raw binary files and ASCII files, this
allows the user to pick which aspect of the naming scheme the user wants to have in the file name.

Auto File Name Date Separator
Select character to use between date items.

Using space characters is not recommended. It’s not supported for USB sticks and in QNX 4, you
have to do extra work with those files.

Auto File Name Date/Time Separator
Select character to use between date and time.

Using space characters is not recommended. It’s not supported for USB sticks and in QNX 4, you
have to do extra work with those files.

Auto File Name Time Separator
Select character to use between time items.

Using space characters is not recommended. It’s not supported for USB sticks and in QNX 4, you
have to do extra work with those files.

Use OS Time / Use M300 Time
This option allows the user to use OS time or M300 time for the file names. The default is to use
M300 time.

When you use M300 time, it selects the time from the M300 files.

When you use OS time, it selects the QNX 4 OS time.

Common Files Directory / Button
The common files directory holds files which are not in the M300 project directory.
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These are files which can be used by many projects. For example, if you have a lookup file
rosemt.lup, it can be placed in the /m300 directory and then used by any M300 project.

The default directory for this is /m300.

Map Files Directory / Button
The map files directory holds map/position files which are not in the M300 project directory.

This allows the user to have on global map file in the maps directory that can be used in any M300
project.

The default is /maps directory.

Probe Files Directory / Button
The probes files directory holds probe information files which are not in the M300 project directory.

This allows the user to have a global location for probe files, for example fssp.prb. This can be used in
any M300 project.

The default is /probes

Data Files Directory
The data file directory can be used setup a global location for the M300 raw binary files (*.sea).

Having a directory name without the ‘/’, will create the data files directory off the project directory.
This allows the project and data files to be separate.

If you use ‘/’ in the name, this implies a directory off the root directory.

The default is sea.

ASCII Files Directory
The ASCII file directory can be used setup a global location for the M300 ASCII files (*.csv).

Having a directory name without the ‘/’, will create the ASCII files directory off the project directory.
This allows the project and ASCII files to be separate.

If you use ‘/’ in the name, this implies a directory off the root directory.
The default is csv.

Picture Files
The pictures file directory can be used setup a global location for the M300 picture capture files
(*.bmp, *.jpg, *.tif).

Having a directory name without the ‘/’, will create the picture files directory off the project
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directory. This allows the project and picture files to be separate.

If you use ‘/’ in the name, this implies a directory off the root directory.
The default is pic.

GENERAL TAB

Port Name
This is the name of the UDP port to be used. This is from the /etc/services file (near end of file).

The port will be used to read data if in UDP mode.

The port will be used to write data if the system is in acquisition or playback mode and the broadcast
button is clicked.

Broadcast Address
This is the IP address for broadcast.

Delay
Delay value in micro seconds to wait if doing a broadcast in playback mode. This is for playback
only, it has no effect in acquisition mode.

During playback, if the user is broadcasting network data, the playback can run really fast. When too
many data packets are broadcast fast, it will increase the chance of lost data packets. If you increase or
change the value this will affect the data loss rate.
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History Count, File, Project, Window, Command
This allows the user to change the number of entries for the history of files, projects, windows and
commands.

Hide/Restore PDM (Photon Desktop Manager)
Hide and restore PDM when M300 does play/stop or enter/exit (star M300 /exit M300).

When M300 runs it’s always best to have as much desktop space available for the project windows.
The PDM uses some space at the bottom of the display. This allows the user to hide the PDM if
desired.

Project Files
Allow write permission to M300 project files.

While M300 is running, if the project is changed, the user will be asked to save the project on exit.
Assuming the user asks to save the project, if the user was ending any M300 file, such as fml.300,
that file would be overwritten.

To avoid confusion, the user should not change any project files while the M300 is running with the
editor. Having the editor open (like vedit) while M300 is running, has another problem. The M300
can setup function keys to execute command globally. This has the potential to interfere with the
vedit when the user is in vedit making changes.

Confirm Exit
This option when clicked will ask the user for extra confirmation before exiting the M300.

This is to avoid undesired termination of the M300 system, specially in aircraft environments where
it’s hard to operate the mouse/keyboard while in turbulence.

Delta Time to cause Init Reset
When working with M300 data that has been acquired with time synchronization to another source
(usually IRIG-B), if the adjustment in time is forward, this is okay with the M300 Trigger frequency
values.

However, if the adjustment is backwards this will cause issues with Trigger frequency values around
the time the data was synchronized.

Having this variable allows use to correct for this and trigger on all the data as expected.

Depending on how big the adjustment was, you might use a 1 or 2 second value for this variable.

This option is only used for playback. The time is in seconds.
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PRINT TAB

Window Printer/Capture
The window printer/capture drop down list allows the user to select the printer, bitmap capture to
(bmp), capture to JPEG (jpg) file or capture to TIFF (tif) file.

Done
Apply and accept changes and close dialog.

Apply
Apply and change the settings.

Cancel
Closes the dialog box.
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OPERATING INSTRUCTIONS

The M300 has three distinct operational modes. Acquisition, Playback and UDP are all modes in
which the M300 can be used to process data.

The M300 software allows the user to have more than one M300 session (project), running on each
system. This creates confusion, at first, on how to distinguish between starting a new session or
bringing an existing sessions to front.

START A NEW M300 SESSION

When you click on the M300 icon from the SEA Tab, you start a new session of the M300 software.
For each session of the M300 software you are allowed to open a project and work with it.

Note: This doesn't bring an existing M300 main window to view. This creates or opens a new M300 session.

Only the first session of the M300 software allows the user to do Acquisition mode.

All other sessions of the M300 must be either in be Playback or UDP mode.

The maximum number of M300 sessions at one time is 26. The M300 uses the letters a to z, to
differentiate between sessions.

BRING TO VIEW AN EXISTING M300 SESSION

When you go to the Photon task bar you can see all the sessions that are running and the display
windows for each of the sessions. When you click on the M300 button in the Photon task bar you
are bringing into view a particular M300 main window.

Note: This doesn’t start a new session of the M300. This brings an existing M300 main window to view.
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ACQUIRING DATA

To acquire data with the M300 system is fairly easy.

1. Start M300 system (See “How to Start M300”  on page 34).
2. Load the desired project (See “Open Project”  on page 93).
3. Pick acquisition from the mode group. This is the first button from the tool bar (See “Tool Bar”

on page 59).
4. Create a data file by typing file create in the command list (See “Command Bar”  on

page 61). This automatically creates a file. Also you can use the file menu (See “File Menu”  on
page 54).

5. If the record button is not pressed, click on it to set the record on (See “Tool Bar”  on page 59).
6. Finally you click on the play button from the M300 tool bar (See “Tool Bar”  on page 59).

Once the M300 is running and acquiring data you should always make sure of the following.
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1. There are no errors in the error status and no errors in the M300Logger window. Any errors there
and you need to track down the source of the errors to get rid of them.

2. The Write To field in the Status Tab, should have the name of the M300 file you are using to
acquire data to.

3. The record section of the Status Tab, must be ON and in green color (see picture above). Also
the record total field and record rate must not be 0. Otherwise you are not recording the data.

WARNING: Always make sure that after you record the data file, you can playback the data file without any
errors on the M300 window. The data that you are playing back, should look exactly like the data acquired.

WARNING: After the data file is collected, the user should backup the data file to another system.

We cannot overemphasize the vital importance of making sure that the data is acquired and is
acceptable.

Note:  RawView can also be used on M300 data files to make sure the file is good. With RawView you can
actually look at the raw recorded data for the M300 sea binary files. See the SEA QNX 4 Utilities in the SEA
Photon Utilities section, RawView. http://www.scieng.com/pdf/SeaUtils.pdf

WHAT TO DO ONCE YOU ARE DONE WITH ACQUISITION

Now that you are done with acquisition, you need to know what do with the M300 system.

1. The first thing we must locate the M300 main window.

Note:  At times with so many display windows open that it’s hard to locate the M300 main window. When
you start M300, the M300 system first start the M300Logger and then the M300. If you look in the Photon
task bar, you can locate the M300 icon and click on it. See picture above.

2. You might decide to click on the stop button before you exit the M300 (See “Command Bar”  on
page 61). The M300 remembers the state of the Stop/Play buttons. If you exit the M300 while in
play mode, the next time you start the M300 it will start to run right away.

3. From the File menu, select Exit. (Shortcut: Alt + F, X) or click on the close symbol (“X”) in the
upper right corner of the main interface window. 

4. If there were any changes made while the M300 was open, an option to save changes will be
given. Select Yes to save changes, or No to exit without saving any of the changes made. (this
saves the project only, not the data files).
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PLAYBACK DATA

To playback data with the M300 system is fairly easy.

1. Start M300 system (See “How to Start M300”  on page 34).
2. Load the desired project (See “Open Project”  on page 93).
3. If the M300 system was left in play mode, then click stop button first.
4. Then we must pick playback from the mode group. Basically we click on the second button from

the tool bar (See “Tool Bar”  on page 59).
5. Then must open a data file. I used the file menu and opened a file that was in the file menu

history. (See “File Menu”  on page 54).
6. Finally you click on the play button from the M300 tool bar (See “Tool Bar”  on page 59).
7. If you need to change the playback speed, click on the Playback Tab and leave there so you can

modify the playback speed (See “Playback Tab”  on page 68).
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Once the M300 is running and playing back data you should always see time incrementing on your
display window and the data that was acquired will start to display.

WARNING: Always make sure that after you record the data file, you can playback the data file without any
errors on the M300 window. The data that you are playing back, should look exactly like the data acquired.

To change the playback speed you can go to the Playback Tab (See “Playback Tab”  on page 68).

If you wish to speed up the playback and you don’t care about generating ASCII files, you can turn
off the ASCII record (See “Command Bar”  on page 61).

To speed up the playback speed, when you want to generate ASCII files and don’t care about looking
at the M300 displays, turn off the displays (See “Command Bar”  on page 61).

To pause the M300 while playing back data, you can click on the pause button (See “Command Bar”
on page 61). To un-pause the M300 click on the pause button again. The pause in the M300
window pauses playback, all displays will stop updating.

To rewind to the start of the data file use the rewind button (See “Command Bar”  on page 61). This
gives the user a chance to play the data again, without having to exit M300 system. If you do this and
are generating ASCII data files you should be aware that some ASCII data might be there more than
once.

To go to the end of the file, you can click the end button (See “Command Bar”  on page 61). Usually
you do this when you playback a data file from another node (remote over the network) where the
M300 is acquiring data and recording to a file.

Another useful button during playback is the next buffer button. This button allows the user to
playback one data buffer at a time. If the user holds down the next buffer button, then repeated
requests are made. Typically you use this while trying to narrow in on a particular section of the data
(See “Command Bar”  on page 61).

BROADCASTING DATA

These steps apply to both acquisition and playback mode.

In UDP mode you are not allowed to re-broadcast the data.

1. Prior to broadcasting data, ensure you have configured the M300 UDP properties correctly (See
“QNX Setup for M300 UDP Operations”  on page 43).

Note:  In the M300 systems that SEA sets up, the UDP broadcast and receive is tested to make sure the
systems are configured correctly.
DATA OPERATIONS83



SEA M300 USERS GUIDE
2. Start M300 and setup the system for either acquisition mode (See “Acquiring Data”  on page 80)
or playback mode (See “Playback Data”  on page 82).

3. Click on the Toggle Broadcast button and make sure it’s depressed (See “Command Bar”  on
page 61). 

4. If the M300 is not in play mode, make sure you click on the play button (See “Command Bar”
on page 61).

Once you click on play and the broadcast button is clicked other systems in the M300 in UDP mode
should start to see the data. To see how to setup the M300 to run using UDP mode (See “UDP”  on
page 84).

If the systems using UDP are not seeing the data, then we need to start the troubleshooting for this.

1. Usually the first thing to do is to check and make sure the systems are connected together. The
M300 systems should be connected to Giga bit hub when possible (specially if are concerned
about network speed issues).

2. You can use netinfo -l to see information about the network card. Both the receive and
transmit sides should have a value for number of total packets. If these are 0, then this would be a
problem.

3. You can use the alive command to see if the QNX 4 machines are on the network (this assumes
all machine have different node numbers and are connected).

4. Use the ping to see if machines in the TCP/IP side of things can see each other.
5. Possible missing network ports in the /etc/services file.
6. For instructions on the TCP/IP setup (See “QNX Setup for M300 UDP Operations”  on

page 43).

UDP

    To use M300 system is in UDP mode is fairly easy.
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1. Start M300 system (See “How to Start M300”  on page 34).
2. Load the desired project (See “Open Project”  on page 93). Since we are using UDP mode, the

project used should be similar to the project that is getting used to broadcast the data.
3. If the M300 system was left in play mode, then click stop button first.
4. Pick UDP icon from the mode group. This is the third button from the tool bar (See “Tool Bar”

on page 59).
5. If you wish to create a file to record the data you can do it if you like. Just keep in mind that

UDP protocol is unreliable and it doesn’t receive all the data that was transmitted. You can use
the file menu (See “File Menu”  on page 54).

6. If the record button is not pressed, click on it to set the record on (if you wanted to record the
data) (See “Tool Bar”  on page 59).

7. Finally, you click on the play button from the M300 tool bar (See “Tool Bar”  on page 59).

Once the M300 is running in UDP mode you should see the time incrementing.

The time will match the time of the system that is being used to transmit the data.

The reason we use UDP mode is for large project setups with several systems setup together. The user
that is using the M300 in UDP mode as a system entirely to his disposal.

The project can be setup differently if so desired.

The user can look at different data displays as the ones that are being used in the Main M300 system
that is used to acquire and transmit the data over the network.

HOW DO I RUN MULTIPLE M300 SESSIONS

Most M300 users will only run one M300 session at a time. This session will either be in Acquisition
mode or Playback mode.
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For users with multiple systems and large setups sometimes the situation arise where it’s necessary to
run multiple M300 sessions.

When you run multiple M300 sessions and open more than one project, you might need to modify
or change your projects to allow you to see the necessary M300 displays.

To run multiple sessions, you would start by.

1. Start the first M300 session.
2. If you need it in acquisition mode, (See “Acquiring Data”  on page 80).
3. If you need the session in playback mode, (See “Playback Data”  on page 82).
4. If you need it in UDP mode, (See “UDP”  on page 84).
5. Now you are ready to start the next session.
6. If you need the session in playback mode, (See “Playback Data”  on page 82).
7. If you need it in UDP mode, (See “UDP”  on page 84).
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HOW TO SETUP BROADCAST FOR MULTIPLE SYSTEM

There are times were UDP broadcast (send) might be required for more than one system at a time.
I’m going to assume that both M300 systems will be in acquisition mode.

Since only one M300 system is allowed to send on a port, we must make sure that both M300
systems that are going to send data will be using different ports.

For the M300 systems we have two ports in the /etc/services files for UDP broadcast. We can add
more if necessary.

sea-udp     2001/udp
radar-udp   2000/udp

For the first M300 system.

Start the M300 and then change the UDP broadcast settings.

To change the UDP settings for the M300 (See “General Tab”  on page 76).

We will setup the Port Name to sea-udp (port 2001).

Then we can follow the instructions for Acquisition mode, (See “Acquiring Data”  on page 80).

We will need to make sure we enable the broadcast button (See “Broadcasting Data”  on page 83).
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For the second M300 system.

Start the M300 and then change the UDP broadcast settings.

To change the UDP settings for the M300 (See “General Tab”  on page 76).

We will setup the Port Name to radar-udp (port 2000).

Then we can follow the instructions for Acquisition mode, (See “Acquiring Data”  on page 80).

We will need to make sure we enable the broadcast button (See “Broadcasting Data”  on page 83).

HOW TO SETUP UDP RECEIVE FROM MULTIPLE SYSTEM

We will assume that both M300 systems for UDP will be done in the same system.
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For the first M300 session.

Start the M300 and then change the UDP broadcast settings.

To change the UDP settings for the M300 (See “General Tab”  on page 76).

We will setup the Port Name to sea-udp (port 2001).

Then we can follow the instructions for UDP mode, (See “UDP”  on page 84).

Make sure you load the correct project for the data that you are receiving. This project should match
the same M300 project that is being used to broadcast the data.
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For the second M300 session.

Start the M300 and then change the UDP broadcast settings.

To change the UDP settings for the M300 (See “General Tab”  on page 76).

We will setup the Port Name to radar-udp (port 2000).

Then we can follow the instructions for UDP mode, (See “UDP”  on page 84).

Make sure you load the correct project for the data that you are receiving. This project should match
the same M300 project that is being used to broadcast the data.
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PROJECT MANAGEMENT

This section of the M300 Users Guide provides assistance with setting up and managing M300
projects. An M300 project is a directory with all of the necessary configuring files necessary to run a
particular project. These files include the configuration files for the data displays of that particular
project. This guide, used in conjunction with the rest of the M300 Users Guide and the M300
Reference Guide, should give you a good technical support base for the configuration and
management of your own projects.

Note: M300 projects should be backed up regularly. Save all project files (i.e. *.300, *.wnd, *.asc, etc.) from
the project directory. Other directories (i.e. /m300, /project, /maps, etc.) may have to be backed up as well.

Note:  It is recommended that before you begin to set up new projects, you completely familiarize yourself
with the M300 Main Window. During these instructions, we will refer to this window often.

Note: Project setup requires a strong degree of familiarity with M300 setup tables and configuration files. If
you feel you require assistance with this, please contact SEA Tech Support.

Configuring a basic project is not that difficult. The M300 supports such a broad base of acquisition
sources. M300 must know, for each project, exactly what data to acquire, record, display, etc.

When working with a M300 project, the user should click on the Stop button first before making
changes to the Project. The M300 doesn’t care about the changes being made.

Once the changes are made to the M300 project, the user must hit the Play button (if M300 was
running, it must be stopped first before you can click Play).

There is more than one way to set up a new project under the M300. A user may copy the contents
of one project directory into the contents of another project directory and rename it. Another
method is to create a new directory for the project and develop the configuration files from scratch.

We recommend using the /check directory for general purpose type projects for the user to test
different aspects of the M300 system. We will use the /check directory in this book.

If the /check doesn’t exist in your system, then run the following commands.

sudo mkdir /check
sudo chmod a+ w /check

We also assume M300 is running, when we give the instructions in this book.
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NEW PROJECT

Note: M300 projects cannot be saved onto the root directory ‘/’. Users must first create a directory from the
root directory (i.e. /2001) and then create the project off of that directory (i.e. /2001/hurricane).

1. In the Project menu, select New (Shortcut: Alt+P, N).
2. In the Subdirectory List, select which directory the new project is to be placed into or to go up

one level, select the folder named ‘..’, which is the parent folder.
3. Alternatively, you may select the path to the project in the Path drop down list. This keeps a list

of the most recently used project path names. This project path list is used in the other project
menus as well.

4. Type the project name you want in the project field and click on New. If you wish to cancel this
operation at any time, click on Cancel.

Note: The project name must not contain spaces. Spaces are hard to deal with in QNX 4 system. Keep the
project names meaningful, but simple. All project names are case sensitive.

5. If there was a project previously opened and it was modified, you will be asked to save that
project.

WARNING: If you create a project with a name that already has been created in that directory, it will not be
possible. You must first remove the project. We have done this to prevent overwriting of project directories.

6. A new project folder with the name of the new project will be created.

To configure a new project, (See “Configure a New Project”  on page 96).
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OPEN PROJECT

1. In the Project menu, select Open.(Shortcut: Alt + P, O)
2. In the Subdirectory List, select which directory the project is in or to go up one level, select the

folder named ‘..’. 
3. The Path list will give you a quick list of the most recently used projects. This project path list is

used in the other project menus as well.
4. Select the directory you want and click on Open. If you wish to cancel this operation at any time,

click on Cancel.
5. If there was a project previously opened and it was modified, you will be asked to save that

project.
6. The project is loaded into the M300. The current project name is displayed in the M300 title

bar. Also, you should have displays/board/acquisition that go with the project.

Note: As the user uses projects, they get added to the project history list in the project menu. If the project
you want to open is on the list, you can open it there.

SAVE

If you are certain that the changes you have made to the M300 project are desirable, then you can
save the project.

1. In the Project menu, select Save. (Shortcut: Alt + P, S).
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SAVING AS

1. In the Project menu, select Save As. (Shortcut: Alt + P, A).
2. In the Subdirectory List, select which directory the new project is to be placed into or to go up

one level, select the folder named ‘..’.
3. The Path list will give you a quick list of the most recently used projects. This project path list is

used in the other project menus as well.
4. Type the new project name you want in the Project field and click on Save. If you wish to cancel

this operation at any time, click on Cancel.

Note: The project name must not contain spaces. Spaces are hard to deal with in QNX 4 system. Keep the
project names meaningful, but simple. All project names are case sensitive.

WARNING: If you create a project with a name that already has been created in that directory, it will not be
possible. You must first remove the project. We have done this to prevent overwriting of project directories.

5. If there was a project previously opened and it was modified, you will be asked to save that
project.

6. A new project folder with the name of the new project will be created. The project will have the
same information as the project that was open.

Note: The M300 does not save some files that open for read only purposes. For example, the cdp30.def. This
files would have to get copied manually.
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DELETE PROJECT

1. In the Project menu, select Delete. (Shortcut: Alt + P, D)
2. In the Subdirectory List, select the directory which holds the project that is to be deleted or to go

up one level, select the folder named ‘..’.
3. The Path list will give you a quick list of the most recently used projects. This project path list is

used in the other project menus as well.

Note: If you are attempting to delete the project you currently have open, you must first close that project
before deleting it. This can be done by opening another project.

4. Once you have selected the project name you want to delete, click on Delete. If you wish to
cancel this operation at any time, click on Cancel.

5. The project folder with the name of the new project will be removed.

WARNING: Once the project is deleted it cannot be undone.

If the user wants to remove a project using the QNX 4 remove command it can be done from a
terminal window. For example, if the user wants to remove the ‘/check/test’ project, he can type.

/bin/rm -fR /check/test

This will remove the test project folder off the /check folder.

WARNING: When using the /bin/rm remove command, use caution. This cannot be undone. Make sure the
folder you are about to remove is the correct one.
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CONFIGURE A NEW PROJECT

Use the instructions in the (See “New Project”  on page 92), to create a new project. The path we will
use is /check and the project name is demo, We end up with a /check/demo project.

The project just created is empty. If you look at the M300 menus for board, acquisition and buffer
setup it’s all empty. All the project trees are blank.

Another peculiarity of an empty project, is that you are not allowed to do acquisition on it. Since
there is no system board present.

All M300 projects must have one and only one system board. This is usually the first step when we
create the project.

Use the instructions in the (See “Board Setup”  on page 105), to open the board dialog.
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As you can see the demo project has no boards in the board project tree.

The default board type is ‘System’, which is the type of board we want to add. Type ‘system’ for
Name and leave the Number at 0. Basically, we are adding a system board number 0.

Click on Insert.

Leave all the parameters in the default values. Click Done to finalize the insert of the board.

Note: For a full description of the system board dialog, (See “System Board”  on page 163).

When you go back to the board setup, you see now that the system board is part of the demo project.

When finished, close the Board Setup dialog, click on Done, again.

When the Board Setup closes, you will see the M300 main window in the front. You should notice
that the ‘ACQ’ button is now enabled in the tool bar. We can click on the ‘ACQ’ button and then
we can click on the Play button.

When you look at the M300 main window it will display date and time, with the time increment at 1
hz. This means M300 is configured and running.
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Exit the M300 and save the demo project. We will see how to add another board to this project next.

Start the M300 and go into the board setup again (See “Board Setup”  on page 105).

As you can see the demo project has a system board in the board project tree.

We will add a SEA Bus (SBus), type board next. This board allows you to add analog acquisition
events to the project.

Pick Type ‘SBus’ from type first and then for Name use ‘sbus’ and change the Number to 1. This
adds an sbus board number 1 to the project. We pick number 1 and not 0, since we used 0 before for
the system board.
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Click on Insert.

Use the default values. Click Done to finalize the insert of the board.

Note: For a full description of the sbus board dialog, (See “SBus Board”  on page 156).

When you go back to the board setup, you see now that the system and sbus boards are now part of
the demo project.

Close the Board Setup dialog, click on Done, again.

Exit the M300 and save the demo project.

As you can see adding boards to the M300 project is straightforward. The user can determine which
instruments they need for a project and from the instruments they can get a list of the necessary
boards to support the instruments.
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If you want to see which files are part of the M300 demo project, open a command window and then
type.

cd /check/demo
ls

This will give you a similar list of files as in the picture above. The project so far has acquisition
(acq.300), board (brd.300), buffer (buf.300), configuration (cfg.300), project (prj.300), sbus.brd and
system.brd files.

The next section shows how to add an acquisition event to the demo project.
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SETUP

M300 setup information for board entries, acquisition event entries and buffer.

GENERAL SETTINGS

There are several aspects of the board dialogs that are common to most boards.

Address
The address of the board uniquely identifies the board entry. The same applies to the board name.

The M300 will give you a warning if there is an address conflict and the board can’t be added at the
address requested. If this is the case, you must pick a different address.

The board address is derived from the ISA hexadecimal boards. Each ISA board in the PC must have
a unique address, otherwise there will be an address conflict and the boards will not work.

With the added support for PCI cards, QNX 4 serial board type devices (/dev/ser2, /dev/ser3),
Network board type devices, etc, it was necessary to assign a pseudo address to these devices so it
would work in the M300 methodology.

Note: For a complete list of board addresses go to, http://www.scieng.com/pdf/IOMap.pdf

Port
Contains the name of the communication serial port. For /dev/ser1 the pseudo address is 0xFF01.
For /dev/ser2 the pseudo address is 0xFF02 and so forth.

The name of the serial ports must be configured to /dev/ser1, /dev/ser2, etc. This is so that the M300
can do pattern matching on the port name and determine if the port is a valid serial port.

When you type the port number and hit the enter key, the dialog will fill in the board address.

For most boards, the user must use the real ISA address from the board or serial port as the source.
There a special address of 0xFFFF that can be selected when using the serial port type devices. The
correct pseudo address will be used.

Make sure no other applications outside the M300 are using the serial ports that are being used by
the M300. Depending on what those applications are doing this might not work with the M300.

State
Controls the item state. Setting the state (toggle button becomes purple) enables the item, while
disabling the state disables the item.
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This is used for acquisition mode.

PB/UDP
Controls whether or not the board will be used during playback and broadcast.

Data Bits
Data bits used in the serial protocol interface. Check information for instrument for the right
settings.

Stop Bits
Stop bits used in the serial protocol interface. Check information for instrument for the right
settings.

Baud
Baud rate used in the serial protocol interface. Check information for instrument for the right
settings.

Parity
Parity used in the serial protocol interface. Check information for instrument for the right settings.

DMA
The DMA channel for imaging cards. Using DMA for the image transfer frees up the CPU board.

The DMA channels available are 5, 6 and 7. Each DMA board cannot be used by more than one
card.

Done
Applies changes and closes the dialog window.

Default
Default values are used for all items in the dialog.

Cancel
Exit the dialog without making changes.
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BOARD SETUP

1. In the Setup menu, select Board. (Shortcut: Alt + S, B)

All the M300 functionally as far as acquiring real time data goes through boards. The boards are the
basic entity that is present in the system.

Each board type dictates the possible acquisition sources for data. So, off each board we have the
acquisition events.

Home
Moves the selected board to the top of the list.

End
Moves the selected board to the bottom of the list.

Up
Moves the selected board up the list by one.

Down
Moves the selected board down the list by one.

Board Tree
At the head of the tree is the project name. All the boards present in the project are part of the tree.

To insert a new board, you must first click on the project name which will enable the insert button.
You must also provide a board name, number and the type of the board.

If you wish to modify board settings, you must first click on the board. Then you can click on the
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modify button.

To remove a board, you must first click on the board on the tree. Then you click the remove button.
Once you remove the board it is gone from the project. This operation can’t be undone. If you don’t
want to change the project, then exit the M300 and don’t save the project when asked.

After you remove/modify the board name, the board files is still present in the system. If needed, it
must be removed manually. Having extra board files that are unused is confusing.

Boards with the state on are shown with a green dot before the board name. These are available for
acquisition.

Boards with the state off are shown with a red dot before the board name. These will not be used for
acquisition. The board address is still present and available for the system.

Name
This is the name of the board that was given by the user. The name of the board is case sensitive and
must be unique.

To modify the board name, the user can select it and change it to a new name. All entries in the
buffer table (buf.300) and acquisition table (acq.300) that use the name are also updated. However it
is impossible to change board name entries in other tables, such as formula (fml.300), buttons
(btn.300) and commands (cmd.300). The user must change these references manually, if
appropriate.

WARNING: Don’t use spaces for board names. The board names use files and commands and this makes it
hard to work with.

Board Type
Board type to be added to the board list. The M300 provides the user with a list of all the valid board
types supported by the system. This makes it easy to add a board.

You must pick a board type before inserting a new board.

You can’t modify the board type once the board as been inserted into the project.

Insert
This will insert the newly selected board to the list. You must first click on the project name from the
board tree.

For a list of boards and their settings (See “Board Setup Dialogs”  on page 116).

Remove
Removes the selected board from the list. You must first click on the board name.
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Modify
Accesses selected board parameters so they can be changed/reviewed. You must first click on the
board name.

For a list of boards and their settings (See “Board Setup Dialogs”  on page 116).

Done
This will close the board setup window. Any changes made will be accepted. If you don’t want the
changes to take effect, don’t save the M300 project.

If you are happy with the changes to the board setup, you can exit and save the project or just save
the project (from M300 project menu).
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ACQUISITION SETUP

1. In the Setup menu, select Acquisition. (Shortcut: Alt + S, A)

The M300 provides a graphical interface for managing the project acquisition setup. Acquisition
events can be added, removed or modified at any time from this dialog.

Acquisition events added/modified with the acquisition dialog are part of the acq.300 project file.
The M300 dialog for acquisition uses the board setup, acquisition setup and buffer setup.

Name
Name of the acquisition event assigned by the user. The name must be unique.

Number
Unique tag number used to identify the acquisition event.

State
The acquisition event state. When the state is disabled this acquisition event is not used by the
acquisition manager.

Frequency
Desired acquisition event sample frequency. This can be between 1 and the maximum system
frequency (specified in the system board entry).

Size
Data size for acquisition event. This value changes from acquisition event to acquisition event.
Consult the acquisition type, in the M300 Reference manual for information on the valid data sizes
SETUP108



M300 USERS GUIDE  SEA
for each acquisition event type. When you use the acquisition setup dialog in the M300, the data size
will get filled automatically for most acquisition events. There are some acquisition events where the
data size must be provided by the user. If the size of the data is overridden care must be taken to
ensure that a large enough value is specified.

WARNING: Not specifying a large enough data size is a serious problem which might cause the M300 to crash.
At the very least the data will be missing or incorrect.

Type
This is a drop down menu that lists all of the available acquisition types for the specific acquisition
board the acquisition event is being added to.

The M300 is smart when presenting the list of acquisition types. It will only list the types that are
valid for the selected board. This prevents setting up invalid acquisitions to the incorrect board type.

WARNING: A word of caution when setting up the acq.300 table manually with the editor. The user must
ensure proper acquisition is done to the correct board types.

Note: For a complete list of the acquisition types, consult the M300 Reference Guide, acquisition section.
http://www.scieng.com/pdf/M300Reference.pdf

Para 1, Para 2 and Para 3
These are extra configuration/setup parameters for the acquisition event. The meaning of these
parameters changes from acquisition type to acquisition type. Consult the acquisition type reference
manual for information on the valid parameter values for each acquisition event type. In the M200
system, these parameters sometimes configured how a particular interface card was setup. Since we
now have entries for each interface in the board table, some of these parameter values are not the
same as in the case of the M200. When a parameter is used to configure the acquisition event, we
have kept the same configuration values as the M200 system.

Offset
The sample offset select in which acquisition tick the acquisition event gets acquired. In the past all
synchronous acquisition events got done in the first tick. This can overload the first tick. Usually the
duration in the proxy was longest for the first acquisition tick. We can balance the acquisition load
over several ticks (allowing us to do more).

This only applies to synchronous acquisition events. For asynchronous acquisition events, leave it at
zero.

Home
Moves the selected item to the top of the list. This changes the order of the acquisition event in the
acq.300 file. This is not the order in which the acquisition events will get acquired. The order for the
acquisition events is set in the buffer setup.

End
Moves the selected item to the bottom of the list. This changes the order of the acquisition event in
the acq.300 file. This is not the order in which the acquisition events will get acquired. The order for
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the acquisition events is set in the buffer setup.

Up
Moves the selected item up the list by one. This changes the order of the acquisition event in the
acq.300 file. This is not the order in which the acquisition events will get acquired. The order for the
acquisition events is set in the buffer setup.

Down
Moves the selected item down the list by one. This changes the order of the acquisition event in the
acq.300 file. This is not the order in which the acquisition events will get acquired. The order for the
acquisition events is set in the buffer setup.

Insert
To insert an acquisition event, first you must click on a board entry from the project tree. Then you
can enter all the required values for the acquisition event. Once you are happy with your selection,
then you can click on the insert button.

If you click on an acquisition event from the tree, this will fill in all the information (name to offset).
Then if you click on the board entry (for the same event or another of the same board type), you are
able to modify the acquisition parameters and do the insert.

Remove
First click on the acquisition event from the project tree. Then you can click on remove to delete the
event from the project.

WARNING: Use caution when doing this as there is no un‐delete. If you change your mind, exit the M300 and
don’t save the project.

Done
This will close the acquisition setup window. Any changes made will be accepted.

WARNING: If you don’t want the changes to take effect, exit M300, don’t save the M300 project.

If you are happy with the changes to the acquisition setup, you can exit and save the project or just
save the project (from M300 project menu).

Project Tree
The project tree is on the left hand side at the bottom of the acquisition dialog.

The project tree starts with the project name followed by all the boards in the project.

The acquisition events are possible only off each of the board entries. Not all board entries will have
acquisition events.

When you select the project name from the tree all items are disabled. You can’t really do much.

If you select a board entry, then you are able to add acquisition events to the project. You can also
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change the order of the boards in the project tree.

When you click on a acquisition event, you can modify the settings for the event, remove it from the
project and you can change the order in the acquisition setup (acq.300)

Acquisition List
The bottom right side of the acquisition dialog shows the list of acquisition events for the selected
board.

If the number of acquisition events fits in the list, they will all be visible. Otherwise the list will give
the user a scroll bar to select other events in the board.

You can click on an item from the list to select it. You can’t modify the items on the list itself. You
must modify the current item via the top section of the acquisition dialog.

If you pick a different board from the project tree, you will see the acquisition events for that board
in the acquisition list.
SETUP111



SEA M300 USERS GUIDE
BUFFER SETUP

1. In the Setup menu, select Buffer. (Shortcut: Alt + S, U)

The buffer setup dialog allows the user to control almost all the functionality of the M300 related to
the M300 buffers. The buffer numbers get assigned automatically when adding the acquisition
events. If necessary or desired they can be changed manually with the editor for the buf.300 project
file.

Here are a few important items to consider when it comes to the M300 buffer management.

The order of the buffers specified on the tree is the order in which they will be used for acquisition.
The order is important some times critical.

Buffer 0, sync 1 hz buffer must always be at top.

Other sync buffers faster than 1 hz, must follow the sync 1 hz buffer.

Valid buffer numbers are from 1 to 250.

Buffer 251 is reserved for command, buffer 252 is reserved for error, buffer 253 is reserved for
secondary acquisition. These must be last in the project.
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The order of the acquisition events on the tree is the same order in which they will be used for
acquisition.

For the sync type buffers, especially buffer 0, the 1 hz sync buffer, the fastest acquisition events must
be first. This is to avoid sample jitter with sampling time.

Count
The number of buffer to allocate in shared memory for the M300 to use.

When you click on a buffer (number) from the list, the buffer count will show the current value for
the buffer.

If you click on the project name or acquisition event, the buffer count is disabled. The last value
displayed there is shown.

The number of buffers needs to be sufficiently large to ensure that the M300 has enough buffers of
each type to do acquisition, record, broadcast, formulas, displays, ASCII output, etc.

Life, Asynchronous Buffer Frequency / Synchronous Life
In the case of synchronous buffers, the buffer frequency is the buffer life, in other words when the
buffer expires. For the 1 second synchronous buffer, the buffer frequency is set for the same value as
the maximum system frequency specified in the System Board entry. The user cannot modify this
field here.

For example, to have a maximum frequency rate of 100 hz, both the buffer frequency and the System
Board frequency should be set at 100.

In the case of asynchronous buffers, the buffer frequency controls the buffer rearm frequency. This
means the buffer rearm frequency controls the maximum possible number of buffers you can get each
second. In the M200 this was usually specified in PARA 3 of the acquisition table for the master
acquisition event.

For imaging type asynchronous acquisition buffers (2D Grey, 2D Mono, CIP, etc), this means the
buffer rearm frequency controls the maximum number of buffers you can get each second. Assuming
the system frequency is 100 hz and the buffer rearm frequency is 25 hz, this would give at most 25
buffers per second.

For other asynchronous acquisition types, such as serial data, this means the buffer rearm frequency
controls the maximum number of buffers you can get per second. If the data rate of the serial data is
10 hz, then you should typically set the buffer rearm frequency to at least twice as much as the
desired data rate. So this would require a 20 hz buffer rearm frequency.

The system frequency set in the board table, sets the maximum acquisition frequency. In the case of
the buffer rearm frequency, the system frequency limits the number of possible buffer rearm
frequencies.
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For a system frequency of 100 hz, buffer frequencies of 20 hz and 25 hz are possible.

For a system frequency of 160 hz, buffer frequencies of 20 hz is possible, but 25 hz would not be
possible. For system frequency of 160 hz, the next possible frequency after 20 hz is 32 hz.

State
Buffer state to turn on or off a particular buffer.

Record
Buffer record state to turn on or off recording of a particular buffer. If the state is turned off these
buffers will not be recorded by the M300 record manager (m300r).

Broadcast
Buffer broadcast state to turn on or off broadcasting of a particular buffer. If the state is turned off
these buffers will not be broadcast by the M300 broadcast manager (m300b).

Home
Moves the selected item to the top of the list.

End
Moves the selected item to the bottom of the list.

Up
Moves the selected item up the list by one.

Down
Moves the selected item down the list by one.

Done
This will close the buffer setup window.

WARNING: Any changes made will be accepted. If you don’t want the changes to take effect, don’t save the
M300 project.

If you are happy with the changes to the board setup, you can exit and save the project or just save
the project (from M300 project menu).

Buffer Tree
The buffer tree is made up of the project name at the top.

From the name the tree splits into all the buffers in the project.

Each buffer line displays important information about the buffer. It starts with the buffer number,
followed by the type of the buffer (type of the data), (S) for synchronous buffer or (A) for
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asynchronous buffer and the frequency/life for the buffer in hz.

If you click on a buffer from the buffer tree, you can change the order in the list, you can change the
buffer count, state, record state and broadcast state.

For some of the buffers, the user is allowed to change the buffer life/frequency.

Inside each buffer entry from the tree, you will see all the acquisition events (with frequency value)
for the buffer.

If you click on an acquisition event from the buffer tree, you are able to move the order of the
acquisition event (inside the buffer).
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BOARD SETUP DIALOGS

Each board type in the M300 has unique setup parameters. The next sections contains a snapshot,
along with a description of each field of a particular boards setup parameters. For more information
on the setup parameters of a specific board, type, refer to the manufacturers operations manual.

Type Description / Display

1D "1D Board" 

1D256 "1D256 Board" 

2DGrey "2DGrey Board" 

2DMono "2DMono Board" 

AIMMS "AIMMS Board" 

Arinc429 "Arinc429 Board" 

Arinc561 "Arinc561 Board" 

ATDAQ141X "ATDAQ141X Board" 

CAMAC1D "CAMAC1D Board" 

CAMAC1D 256 "CAMAC1D256 Board" 

CAMACAnalog "CAMACAnalog Board" 

CAS "CAS Board" 

CASDPOL "CASDPOL Board" 

CASPBP "CASPBP Board" 

CIP "CIP Board" 

CIPGS "CIPGS Board" 

CYCTM "CYCTM Board" 

CYDDA "CYDDA Board" 

CYDIO24 "CYDIO24 Board" 

CYDISO "CYPDISO Board" 

DT2817 "DT2817 Board" 

GPIBPCII "GPIBPCII Board" 

GPS "GPS Board" 

Board Type
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Network "Network Board" 

PCIDAC "PCIDAC Board" 

Piraq "Piraq Board" 

Piraq2 "Piraq2 Board" 

PMF "PMF Board" 

RTI802 "RTI802 Board" 

SBus "SBus Board" 

SeaCounter24 "SeaCounter24 Board" 

SeaDA "SeaDA Board" 

Serial "Serial Board" 

SerialPort "SerialPort Board" 

SPP "SPP Board" 

System "System Board" 

Type Description / Display

Board Type
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1D BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Command
For FSSP type, this value sets the initial range [0, 1, 2 and 3].

For PCASP, this value sets the initial pump state (0=off, 1=on).

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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1D256 BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Command
For FSSP type, this value sets the initial range [0, 1, 2 and 3].

For PCASP, this value sets the initial pump state (0=off, 1=on).

Size Channels
The number of size channels to acquire.

Source Frequency
Source frequency setting for strobe channels.

Strobe Channels
The number of strobe channels to acquire.

Divide Factor
Divide factor and source frequency are used to setup the timing for strobe channels.

Range
A/D range selection.

Gain
A/D gain selection.
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Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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2DGREY BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

DMA
(See “DMA”  on page 104).

Bit Shift
Controls how fast the image data is transferred from the probe. The length and quality of the
interface cable are limiting factors on the maximum bit shift possible. The higher the bit shift the
more data we can transfer from the probe. 

IRQ
Interrupt channels used by the board to indicate when the data transferred is done. An IRQ cannot
be used by multiple cards in the M300.

Command
Initial command to probe. See the probe manual for detailed information on the command values
possible.

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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2DMONO BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

DMA
(See “DMA”  on page 104).

Bit Shift
Controls how fast the image data is transferred from the probe. The length and quality of the
interface cable are limiting factors on the maximum bit shift possible. The higher the bit shift the
more data we can transfer from the probe. 

Type
Controls which type of acquisition hardware is being used. The 2D Mono board supports both 2D
Mono and HVPS particle measurement probes.

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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AIMMS BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

Data
(See “Data Bits”  on page 104).

Stop
(See “Stop Bits”  on page 104).

Baud
(See “Baud”  on page 104).

Parity
(See “Parity”  on page 104).

Purge Time
The default purge time to use for the AIMMS in ms.

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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ARINC429 BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Receive Speed
Controls the receive speed from the ARINC 429 connected hardware. This setting should match
what the ARINC 429 hardware is set for.

Transmit Speed
Controls the transmit speed to the ARINC 429 connected hardware. This setting should match what
the ARINC 429 hardware is set for.

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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ARINC561 BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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ATDAQ141X BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Analog Input Channel Configuration
See board manual.

D/A Voltage Reference
See board manual.

Analog Control Range
See board manual.

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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CAMAC1D BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Slot
CAMAC slot where the board is installed.

Command
For FSSP type, this value sets the initial range [0, 1, 2 and 3].

For PCASP, this value sets the initial pump state (0=off, 1=on).

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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CAMAC1D256 BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Slot
CAMAC slot where the board is installed.

Command
For FSSP type, this value sets the initial range [0, 1, 2 and 3].

For PCASP, this value sets the initial pump state (0=off, 1=on).

Size Channels
The number of size channels to acquire.

Source Frequency
Source frequency setting for strobe channels.

Strobe Channels
The number of strobe channels to acquire.

Divide Factor
Divide factor and source frequency are used to setup the timing for strobe channels.

Range
A/D range selection.
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Gain
A/D gain selection.

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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CAMACANALOG BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Slot
CAMAC slot where the board is installed.

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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CAS BOARD

Address
(See “Address”  on page 103).

Port
(See “Port”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Data
(See “Data Bits”  on page 104).

Stop
(See “Stop Bits”  on page 104).

Baud
(See “Baud”  on page 104).

Parity
(See “Parity”  on page 104).

Thresholds
Contains the filename for the thresholds file to be used with the CAS board.

Channels
Number of channels to acquire.

Clock Divider
See probe manual.
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Laser Attenuation
See probe manual.

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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CASDPOL BOARD

Address
(See “Address”  on page 103).

Port
(See “Port”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Data
(See “Data Bits”  on page 104).

Stop
(See “Stop Bits”  on page 104).

Baud
(See “Baud”  on page 104).

Parity
(See “Parity”  on page 104).

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).
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Cancel
(See “Cancel”  on page 104).

PBP
This button enable the PBP feature for the CAS DPOL probe

Channels
Number of channels to acquire.

ADC Threshold
Please see the CAS DPOL probe manual.

Num PBP Packets
Number of PBP packets to acquire. The CAS DPOL manual states this must from two to 2047. Also
must enable the PBP button above.

Num Raw Channels
Number of raw channels to acquire. This feature is not implemented please use 0 for this parameter.

Controller 1
Please see the CAS DPOL probe manual.

PBP Size Threshold
Please see the CAS DPOL probe manual.

Controller PBP
Please see the CAS DPOL probe manual.

Controller Raw
Please see the CAS DPOL probe manual.

D/A Controllers
This is the D/A controllers file definition parameters. Please see the CAS DPOL probe manual.

Upper Bin Sizes
This is the upper bin sizes file definition parameters. Please see the CAS DPOL probe manual.
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CASPBP BOARD

Address
(See “Address”  on page 103).

Port
(See “Port”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Data
(See “Data Bits”  on page 104).

Stop
(See “Stop Bits”  on page 104).

Baud
(See “Baud”  on page 104).

Parity
(See “Parity”  on page 104).

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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CIP BOARD

Address
(See “Address”  on page 103).

Port
(See “Port”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Data
(See “Data Bits”  on page 104).

Stop
(See “Stop Bits”  on page 104).

Baud
(See “Baud”  on page 104).

Parity
(See “Parity”  on page 104).

DMA
(See “DMA”  on page 104).

TAS Source
See probe manual.

Small Particle Reject
See probe manual.
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N Value
See probe manual.

Depth of Field Reject
See probe manual.

End Diode Reject
See probe manual.

Use Real Particle Width
See probe manual.

Recovery Coefficient
See probe manual.

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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CIPGS BOARD

Address
(See “Address”  on page 103).

Port
(See “Port”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Data
(See “Data Bits”  on page 104).

Stop
(See “Stop Bits”  on page 104).

Baud
(See “Baud”  on page 104).

Parity
(See “Parity”  on page 104).

DMA
(See “DMA”  on page 104).

Minimum Threshold
See probe manual.
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TAS Source
See probe manual.

Middle Threshold
See probe manual.

Depth of Field Reject
See probe manual.

Maximum Threshold
See probe manual.

Particle Size Measurement
See probe manual.

Grey Level Histogram
See probe manual.

Recovery Coefficient
See probe manual.

Grey Level Image
See probe manual.

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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CYCTM BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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CYDDA BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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CYDIO24 BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Port A, Port B, Port C
Input or output selection. See manual for the board.

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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CYPDISO BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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DT2817 BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Port 0, Port 1, Port 2, Port 3
Input or output selection. See manual for the board.

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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GPIBPCII BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Device Address
Address of the instrument on the GPIB bus.

Command File
Contains the filename that of the command file which contains the sequence of commands to be sent
to the GPIB PCII board.

Capture File
Contains the name of the capture file used to store all the information the GPIB hardware sends back
to the M300.

Log File
Contains the name of the log file used to log all I/O with the GPIB hardware.

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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GPS BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Data
(See “Data Bits”  on page 104).

Stop
(See “Stop Bits”  on page 104).

Baud
(See “Baud”  on page 104).

Parity
(See “Parity”  on page 104).

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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NETWORK BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Protocol
Protocol used by the port/instrument. This can be udp or tcp (most of the time it is udp).

Direction
Data direction, are we sending or receiving. In the M300 system we can do one of these modes but
not both simultaneously.

IP
The IP address to use. When doing udp, for the most part the IP is blank. For the tcp mode it gets
more complicated. Contact SEA for a document on this topic and help with setting this up.

Port
The name or number of the port to use. This is from /etc/services file. If the port is not there, it must
be added. There are a large number of well defined ports for TCP/IP communications. The user port
number should not use any of the predefined ports.

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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PCIDAC BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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PIRAQ BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Memory
PCI memory setting for Piraq board.

IRQ
Controls the Interrupt Request Line used by the Piraq 2 board. Note that some IRQ channels are
reserved and should not be used. Change this value only if you are sure it will not conflict with
another device.

DSP File
Name of the DSP file to load into the Piraq board.

Watchdog
See board manual.

FirstGate
See board manual.

Phase Correct
See board manual.

Clutter Filter
See board manual.
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Time Series
See board manual.

Delay
See board manual.

Timing Mode
See board manual.

Gates
See board manual.

Time Series Gate
See board manual.

Gate Width
See board manual.

Pulse Repetition Time
See board manual.

Hits
See board manual.

Transmitter Pulse Width
See board manual.

Scan Rate
See board manual.

Pulse Rate
See board manual.

Index of Refraction
See board manual.

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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PIRAQ2 BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

DSP File
Name of the DSP file to load into the Piraq 2 board.

Coarse Delay
See board manual.

Fine Delay
See board manual.

Number of Gates
See board manual.

Gate Width
See board manual.

Hits
See board manual.
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Sync
See board manual.

Test Pulse Width
See board manual.

Test Pulse Delay
See board manual.

Frequency
See board manual.

Timing Mode
See board manual.

Trigger
See board manual.

Test Pulse
See board manual.

Time Series Gate
See board manual.

Pulse Repetition Time
See board manual.

Pulse Repetition Time 2
See board manual.

Transmit Pulse Width
See board manual.

Transmit Pulse Delay
See board manual.

Watchdog
See board manual.

First Gate
See board manual.

Phase Correct
See board manual.
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Clutter Filter
See board manual.

Time Series
See board manual.

RF Trigger
See board manual.

RF Switch
See board manual.

Stagger
See board manual.

Velocity Sign
See board manual.

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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PMF BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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RTI802 BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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SBUS BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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SEACOUNTER24 BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Trigger Mode
Valid values for the trigger mode are; rising edge, falling edge and both edges.

Threshold Voltage
The threshold voltage for the SEA COUNTER 24 interface card, the default value is 2.5.

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
SETUP157



SEA M300 USERS GUIDE
SEADA BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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SERIAL BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Data
(See “Data Bits”  on page 104).

Stop
(See “Stop Bits”  on page 104).

Baud
(See “Baud”  on page 104).

Parity
(See “Parity”  on page 104).

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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SERIALPORT BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Data
(See “Data Bits”  on page 104).

Stop
(See “Stop Bits”  on page 104).

Baud
(See “Baud”  on page 104).

Parity
(See “Parity”  on page 104).

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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SPP BOARD

Address
(See “Address”  on page 103).

Port
(See “Port”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

Data
(See “Data Bits”  on page 104).

Stop
(See “Stop Bits”  on page 104).

Baud
(See “Baud”  on page 104).

Parity
(See “Parity”  on page 104).

Thresholds
Contains the filename for the thresholds file to be used with the board.

Trigger Threshold
See probe manual.
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Average Transit Rejection
See probe manual.

Transit Reject
See probe manual.

Average Transit Time Accept
See probe manual.

Channels
Number of channels to acquire.

Divisor Flag
See probe manual.

DOF Rejection
See probe manual.

Count Method
See probe manual.

Range
See probe manual.

SPP100, SPP200, SPP300, CDP, CDP PBP
Selection for the type of probe connected to the port.

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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SYSTEM BOARD

Address
(See “Address”  on page 103).

State
(See “State”  on page 103).

PB/UDP
(See “PB/UDP”  on page 104).

IRQ
Controls the Interrupt Request Line used by the System board. Note that some IRQ channels are
reserved and should not be used. By default, the System board uses IRQ 3. Change this value only if
you are sure it will not conflict with another device. SEA recommends that you do not change this
value.

Frequency
The frequency at which the M300 will run the acquisition manager, IRQ. This is also known as
system frequency or maximum system frequency.

The system frequency must be at least as high as the highest desired acquisition event frequency.

The M300 uses the System board to generate the frequency for acquisition. The crystal oscillator
used is a 4.0 MHz clock. This limits the possible system frequencies to some multiples of this crystal
frequency.

When the user changes the system frequency for a project, this might require modifications to other
parts of the system. Acquisition events need to be checked to make sure their frequencies are possible.

If the changes are being made manually, the buf.300 must change sync buffer 0 frequencies.

Some formula and window triggers might be affected.

Typically when you setup a project, find out what the maximum acquisition frequency is, this will
give you a value for system frequency. Normally a system frequency of 100 hz works for most
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projects. If some of your acquisition rates are higher, then pick a system frequency that is at least as
high as the maximum acquisition frequency.

Mode
These are the BC635/BC637 modes allowed by the M300. See the BC635/BC637 documentation.

The valid modes are, None, Time Code, Free Running, 1 PPS, RTC and GPS.

The mode must be None, when there is no BC635/BC637 present in the system.

The mode must be None, when the user doesn’t want to sync to BC635/BC637.

Difference Limit
When the BC635/BC637 mode is set (not None), this is the number of seconds to set as the
maximum difference allowed between the BC635/BC37 clock and the M300 clock.

This is 0.001 s for normal operation. If the value is too small, this will cause the M300 to make a
large number of unnecessary adjustments. If the number is too large the clocks will not have a good
synchronization.

Clock Source
When the BC635/BC637 mode is set (not None), this should be set to external, and a clock source
must me provided to the board.

If a clock source is not available to the BC635/BC637, this must be set to internal.

IRQ Source
The M300 can use the system board as the main source for acquisition. This is the recommend IRQ
source.

If the system doesn’t have a system board, such as a laptop, but still wants to do acquisition, the PC
Clock can be used to drive the acquisition. This mode doesn’t have the accuracy of the M300 system
board. We don’t recommend using it unless there is no other way.

Done
(See “Done”  on page 104).

Default
(See “Default”  on page 104).

Cancel
(See “Cancel”  on page 104).
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WINDOW DISPLAYS

The data displays in the M300 are used to convey acquired data in immediate, understandable form.
The most commonly used displays are probe image display, strip charts, histograms, maps, text and x
vs. y.

The Photon GUI interface of the M300 allows the user to have as many data display windows as they
wish.

The windows can be spread out throughout the Photon GUI work space, allow for a very large
display area. The user can easily switch between display consoles.

Photon has nine virtual consoles total. Only one console is visible at a time.

M300 systems can be configured with multiple video cards allowing for a large number of separate
displays.

NEW WINDOW DIALOG

This gives the user the means to create a new window. Windows can also be created manually by
adding them to the wnd.300 project file. The corresponding ‘*.wnd’ must also be added (which can
be copied from an existing project).

The user must create a window before they can display on it.

Type
The user can pick the window type. As you can see from the dialog above, the M300 supports several
different types of windows.
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Type Description / Display

2DG "2D Grey Image (2dg.300)" 

2DM "2D Mono Image (2dm.300)" 

BFA Buffer Flow Analyzer (reserved)

BIF Buffer Info (reserved)

CGS "Cloud Grey Scale Image (cgs.300)" 

CIP "Cloud Image Probe (cip.300)" 

FWA "Formula Watch and Alter (fwa.300)" 

HIS "Histogram (his.300)" 

HOD "Hodograph (hod.300)" 

HSA "High Speed Analog (hsa.300)" 

HTI "Height Time Indicator (hti.300)" 

HVP "High Volume Particle Spectrometer Image (hvp.300)" 

LST "List (lst.300)" 

MAM "Moving Air Mass (mam.300)" 

MLT Multi Text (future development)

MPI Moving Position Indicator (future development)

PDI "Probe Distribution (pdi.300)" 

POS "Position (pos.300)" 

PPI "Plan Position Indicator (ppi.300)" 

SKT "SkewT (skt.300)" 

STP "Strip Chart (stp.300)" 

STR String (future development)

TVY Time vs. Y (future development)

TXT "Text (txt.300)" 

VEC Vector (future development)

XVY "X vs. Y" 

Window Type
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Flags
Window render flags allows the user to customize the look and features desired for each window.

Most of the flag names are self explanatory. For example, title will give you the title bar for the
window. Some times after the project is all setup, the user might decide that it’s best not to have a
title bar in a window and use that space instead for extra display.

The front most flag sets the window to be always in front of other windows. Typically, this can be
used for a window (on top/bottom/side area of the display), so that the information displayed in this
window is always visible.

The console switch flag allows the window to switch between consoles. Typically most windows
don’t have this flag set. Occasionally a few windows might have this set, so the information displayed
on that window is always present.

Name
The name of the window. The name must be unique. The name of the window must not have any
spaces. This allows the user to execute commands on a window name.

The name of the window can say a lot about a window if used properly. In the projects we set up, we
use the type of the window as the last characters of the window name. This allows us to determine
the type of the window just by looking at the name. For example, if we have a window to display
analog text data, we can name it “analogtxt”.

Number
This is the number of the window. The window number must be unique. This allows the user to
execute commands on a window number.

Done
This will close the window new dialog and create a new window.

This creates an empty window. The user can resize, move the window and close the M300 and save
the project. Once the displays are set up the window will look normal.

Cancel
This will close the window new dialog and do nothing.
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GENERAL SETTINGS

The M300 has a large variety data displays. However, all displays share some common attributes
which can be modified in the same way. The following section describes the general settings that a
user can make to any data display. Although these are general settings, some displays may make use
of certain settings differently while others may not use some features at all.

The pbphsa window shown here shows all the common features of the M300 displays.

Time
The M300 provides time in all display windows as well as the main M300 window.

During acquisition and UDP modes the time will update with current time from the M300/QNX 4
clock. During playback the time will be derived from the time in the data file.

Most windows will display the time from the sync 1 hz buffer.

If the primary window trigger is based on a another type of buffer, then the time will only updated
based on the trigger specified and available data buffer.

Date
The M300 provides the date in all display windows as well as the main M300 window.

During acquisition and UDP modes the date will update with current date from the M300/QNX 4
clock. During playback the date will be derived from the date in the data file.

Pause Toggle Button
The pause toggle button, if depressed, will cause the M300 display window to freeze and hold all the
current data values unchanged. This allows the user the capability to observe the data.

The user must click the button again to un-set the button and allow the M300 display to continue.

At times, it’s easy to confuse a window that is paused with some sort of system malfunction. Check
the individual window pause or the global window pause (See “Tool Bar”  on page 59).
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Grid Toggle Button
The grid toggle button, if depressed, will show the grid for the display. Some M300 displays, such as
text, have no grid. The grid button would not have an effect for those display windows.

Capture Button (Printer, BMP, JPG, TIF)
The capture button allows the user to quickly send the contents of the window to either a printer or
to a graphics file. The type of the capture is determined in the M300 Properties, Print Tab (See
“Print Tab”  on page 78).

Properties Button
The properties button launches the M300 Window Properties dialog (See “Window Properties”  on
page 169).

Color Button
The color button allows the user to change several of the color properties for the window. This
includes the color for the background, grid, text and 16 different level colors (which are used for
some of the radar reflectivity displays).

Lock Toggle Button
This button allows the user to lock window display if depressed. Otherwise the window is unlocked
and the user can make changes at will.

This is a individual window lock button. The M300 also has a global lock button that locks all the
display windows in the M300 (See “Tool Bar”  on page 59).

The window lock flags must be set for the window to be able to lock (See “Flags Tab”  on page 173).
Otherwise nothing will happen.

WINDOW PROPERTIES

The window properties dialog. This applies to all windows. Not all windows have the same
properties, nor do all windows use all the settings from the dialog.

For example, for a text display it makes no sense to use the xAxis tab and yAxis tab as the text
window doesn’t have any axis to display or change limits.
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XAXIS TAB

YAXIS TAB

Note: The properties options for the x Axis and the y Axis tabs are identical with the exception of the Shift
Left/Right buttons (x Axis only). Note also that some of the options contained in this dialog window do not
apply to all displays. 

Linear, Logarithmic, Time
The type of axis.

Units, Divisions, Pixels, Bins
The type of the grid lines, which format M300 will use.
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Minor
Minor grid lines are shown with one pixel in the M300 display (light). This controls the spacing
between minor grid lines.

Major
Major grid lines are shown with two pixels in the M300 display (heavy). This controls the spacing
between major grid lines.

Minor Grid Line Type
Allows the user to select different types of line formats for minor grid lines (Solid Lines, Dotted Line,
Dashed Line, Top Mark, Bottom Mark, Both Marks).

Major Grid Line Type
Allows the user to select different types of line formats for major grid lines (Solid Lines, Dotted Line,
Dashed Line, Top Mark, Bottom Mark, Both Marks).

Shift Left/Right (x‐Axis only)
Changes the horizontal shifting of the display to the left or the right, respectively. This is used for
strip chart displays and other types of displays where shifting of the xAxis data is involved.

Label
This controls the spacing of the labels for the grid lines (for y or x axis). It’s typical for the label to
match the minor or major grids.

Min
Sets the minimum x/y limit for the graph (supported displays only).

Max
Sets the maximum x/y limit for the graph (supported displays only).

Range
Sets the maximum range or the graph. For example, for strip chart displays this can be set for the
total amount of time in the xAxis.
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TRIGGER TAB

The trigger tab shows the primary and secondary trigger properties to use for the window.

Note: If the user is not familiar with triggers, consult the M300 Reference Guide, miscellaneous reference,
triggers section. http://www.scieng.com/pdf/M300Reference.pdf.

These are the properties for the primary trigger. Most display windows only use the primary trigger.
There are some display windows such as 2D Mono image, 2D Grey image, CIP Image, basically any
image type display which will require a secondary trigger of sync buffer, 1 hz. The histogram window
also uses a secondary trigger of sync buffer, 1 hz.

Type
The trigger type. Most windows will use ‘Sync’.

Frequency
The trigger frequency. Most windows use 1 hz.

Formula
The formula to trigger on. Most windows don’t use a formula (blank entry).

Board
The name of the board for the trigger. Most windows use ‘None’ for the board.

These are the properties for the secondary trigger. There are only a few window displays that will
need the secondary trigger. The image type displays use the secondary display for the sync 1 hz
buffer. The histogram display also uses the sync 1 hz buffer secondary trigger.

Type
The trigger type. Most windows will use ‘Never’.
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Frequency
The trigger frequency. Most windows use ‘Ignore’.

Formula
The formula to trigger on. Most windows don’t use a formula (blank entry).

Board
The name of the board for the trigger. Most windows use ‘None’ for the board.

FLAGS TAB

Render Flags
Window flags allows the user to customize the look and features desired for each window.

Most of the flag names are self explanatory. For example, title will give you the title bar for the
window. Sometimes after the project is all setup, the user might decide that it’s best not to have a
tittle bar in a window and use that space instead for extra display.

The front most flag, sets the window to be always in front of other windows. Typically, this can be
used for a window (on top/bottom/side area of the display), so that the information displayed in this
window is always visible.

The console switch flag allows the window to switch a new console. Typically most windows don’t
have this flag set. Occasionally a few windows might have this set, so the information displayed on
that window is always present.

Lock Flags
The lock flags specify all the different aspects of the M300 displays that can be locked by the user
while the M300 is running.
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There are times where it’s desirable to lock some features of the M300 from being able to be
modified.

For example to lock all the displays inside of a text window, the user can select the raw lock flag.

By default all lock flags are off when a window is created. The user must select the desired locks.

Done
Saves the applies the changes and closes the dialog.

Apply
Saves and applies the changes made

Load
Loads in the current window properties. (If Apply was never clicked, these would be the original
settings before the dialog was open.)

Cancel
Cancels all changes since Apply or Done was clicked and closes the dialog window.

1. On the display you wish to alter, click on the Properties Button in the display control group at
the top of the display.

2. Set the appropriate options in the Properties Dialog according to their descriptions above.
3. Once all options have been selected click on the Done (Shortcut: D) Button in the Properties

Dialog. If you wish to apply the changes without closing the window, you may click on Apply.
(Shortcut: A). You may cancel the operation at any time by clicking on Cancel.

CHANGING A DISPLAY COLOR

Current Color
Currently selected color.
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RGB Value
Displays, in numerical form, the Red, Green, and Blue components of the currently selected color.
Each component can be in the range 0-255 for a total of 16 million colors, depending on the
capabilities of the currently installed video adapter. The user can change these values by directly
overwriting the number currently displayed.

RGB Scale Adjust
Equivalent display to the RGB Values in numerical form, but along a slider instead. Dragging these
sliders will change both the color and the numerical RGB value associated with it.

Color Swatches
These are pre-selected colors for quick selection by the users. They are spread over the entire RGB
spectrum.

Cancel
This allows the user to cancel any changes since Apply or Done was clicked.

Apply
Applies the changes made, but keeps the dialog open.

Done 
Applies the changes made, and closes the dialog window.

1. On the display you wish to alter, click on the appropriate color button. Some displays have more
than one; therefore you should refer to the appropriate display description if you are not sure
which color button you need to click on.

2. Set the color you wish to use.
3. Once the color has been selected click the Done (Shortcut: D) Button in the Properties Dialog. If

you wish to apply the changes without closing the window, you may click on Apply. (Shortcut:
A). You may cancel the operation at any time by clicking on Cancel.
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PRINTING/CAPTURING A DATA DISPLAY

Available Printers
This is a drop down menu containing a list of installed printers. It also contains a BMP Spool driver
which will allow the user to print the portion of the screen to a bitmap file.

Properties
This will bring up the properties dialog for the printer/spool driver that is selected in Available
Printers.

Location of PTF
Used when the user is printing to a file.

Print Range Selection
Allows the user to print specific pages of a document. In this case of the data displays, normally, All
Pages should be checked.

Number of copies
Allows the user to print multiple copies of the document/display.

Collate Selection
When selected, will collate the document.

Print
Finalizes selections and prints the document/display.

Preview
Allows the user to see before printing what the document/display will look like on paper.

Cancel
Cancels print operation and closes the dialog.
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1. On the display you wish to print. Click on the Print Button in the display control group at the
top of the display.

2. Select the appropriate options in the print selector according to their descriptions above.
3. Once all options have been selected click on the Print (Shortcut: P) Button in the Print Selector

dialog. Before doing this, you may click on Preview, (Shortcut: V). This will allow you too see
how the final printout, of the bitmap file, will look before actually printing. You may cancel the
operation at any time by clicking on Cancel (Shortcut: C).
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2D GREY IMAGE (2DG.300)

Particle Image
A reproduction of the shape of the particles that passed through the 2D Grey Probe.

Color Percentages
These percentages are based on the particle density detected by the 2D Grey probe. The buttons
allow the user to select what color is to be associated with a percentage.

Acquisition Address
This is the I/O address that the 2D Grey probe was configured for. Having the address here allows
the M300 to use a number of different 2D Grey probes simultaneously. All the user has to do is
select the particular I/O address of the 2D Grey Image in question.

Scale
This is the scaling factor. A Factor of 1 will display the image as it was recorded. Selecting a scaling
factor higher than 1 will magnify the image by that factor.

Age Limit
This is the limit, assigned by the user, the M300 will use to determine if an image should be
indicated as “old”. For example, if a user inputs an age limit of 10, the M300 will continue to work
as normal. However, if the currently displayed 2D Grey Image becomes 10 minutes old relative to
the M300 system buffer during playback, the M300 will then place hash lines across the image to
indicate to the user that it has gone past its age limit.

2D Grey ‐ scaling the display
1. In the 2D Grey display window you are scaling, click on the Scale drop down menu.
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2. Select the scaling value needed by either selecting a value from the drop down menu, or typing in
the number directly. For the most part, the user will not need to scale the display above 5x.

2D Grey ‐ changing the acquisition address
1. In the 2D Grey display window you are changing the I/O address, click on the Acquisition

Address drop down menu.
2. Select the address needed by selecting a value from the drop down menu.

2D Grey ‐ adjusting the age limit
1. In the 2D Grey display window you are changing the I/O address, click on the Age Limit text

box.
2. Type the value of the age limit desired (in minutes) and hit Enter. At this point the M300 will

display hash lines across any images that are older than this value.
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2D MONO IMAGE (2DM.300)

Particle Color
This number determines which color the Particle image will be displayed in.

Timebar Enable
This option toggles the timebar option which draws horizontal lines illustrating the time slices.

Scale
This is the scaling factor. A Factor of 1 will display the image as it was recorded. Selecting a scaling
factor higher than 1 will magnify the image by that factor.

Age Limit
This is the limit, assigned by the user, the M300 will use to determine if an image should be
indicated as “old”. For example, if a user inputs an age limit of 10, the M300 will continue to work
as normal. However, if the currently displayed 2D Mono Image becomes 10 minutes old relative to
the M300 system buffer during playback, the M300 will then place hash lines across the image to
indicate to the user that it has gone past its age limit.

2D Mono ‐ scaling the display
1. In the 2D Mono display window you are scaling, click on the Scale drop down menu.
2. Select the scaling value needed by either selecting a value from the drop down menu, or typing in

the number directly. For the most part, the user will not need to scale the display above 5x.

2D Mono ‐ changing the acquisition address
1. In the 2D Mono display window you are changing the I/O address, click on the Acquisition

Address drop down menu.
2. Select the address needed by selecting a value from the drop down menu.

2D Mono ‐ adjusting the age limit
1. In the 2D Mono display window you are changing the I/O address, click on the Age Limit text

box.
2. Type the value of the age limit desired (in minutes) and hit Enter. At this point the M300 will

display hash lines across any images that are older than this value.
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CLOUD GREY SCALE IMAGE (CGS.300)
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CLOUD IMAGE PROBE (CIP.300)
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FORMULA WATCH AND ALTER (FWA.300)
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HISTOGRAM (HIS.300)

Sampling Interval
The Amount of time between data sampling.

Current Count
The count in progress at this point in time.

Bin
The histogram graph is a visual representation of the elements in an array. The Bin represents one of
the elements in that array.
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HODOGRAPH (HOD.300)

Altitude
This value is the current altitude of the aircraft during the plot at a specific point in time.

Speed
The rate at which the aircraft is moving at that point in time.

Direction
This is the aircraft’s angular relation in degrees to the original direction of the aircraft when the plot
was initiated.

Clear Plot
Removes the currently displayed plot from the graph.

Rings
Changing this value changes the number of rings displayed on the graph. With this example plot, the
value is five which is why 5 rings are displayed on this graph.

Maximum Limit
The value which restricts the maximum range of the plot.

Direction
This is the current direction of the aircraft in degrees at a specific point in time.
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HIGH SPEED ANALOG (HSA.300)

High Speed Analog ‐ adjusting Y limits
Click on the limits
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HEIGHT TIME INDICATOR (HTI.300)

Intensity in dbz
The amount of energy which is received back at the radar dish is measured in units of dBZ
(decibels * Reflectivity). The higher the dBZ value the larger the object i.e. large raindrops and hail
produce high dBZ values. This chart gives a reference of the dbz value to the plot color.

Noise Level
The amplitude level of the undesired background noise in dBm (milliwatts of power).

Height Intensity
Current height and intensity levels.

Y‐Axis Altitude Minimum/Maximum
Changing these values alters the minimum and maximum altitude for the display.

Color Scheme
A user definable parameter which allows multiple color schemes to be applied to the plot. During the
setup of the HTI the user must create a file which identifies the name of the scheme as well as the
color parameters. The name of this file is rdr.300 and is located in the project directory. This file can
be edited at any time but in order for the changes to take effect the project must be opened after the
changes have been made.

HTI ‐ Determining altitude and intensity of a point

Note: In order to receive a valid intensity reading, you must have selected an area of the graph that has
measurable data plotted; otherwise only the height reading will be available.

1. Position the mouse pointer over the point on the graph you wish to read.
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2. Click on the point you wish to read.
3. Read the height and intensity values from the text boxes.

HTI ‐ Adjusting height limits

Note: Valid upper and lower limits must conform to (lower limit < upper limit).

1. Click in which height limit you would like to change.
2. Enter a new value for the limit (in meters). The M300 will then refresh the height time display to

reflect the limit changed made.

HTI ‐ Adjusting noise level
1. Click on the text box of the noise level you would like to adjust. Note that the upper text box is

for the up-antenna and the lower text box is for the down-antenna.
2. Enter a new value for the noise level (in dBm). The M300 will then refresh the height time

display with the newly entered noise level as a display masking threshold. Note that this new
display masking value will only be in the direction of the applicable antenna.
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HIGH VOLUME PARTICLE SPECTROMETER IMAGE (HVP.300)

Time Bar
A visual representation of a time interval.

Particle Image
A reproduction of the shape of the particles that passed through the HVPS.

Particle Color
This number determines which color the Particle image will be displayed in.

Acquisition Address
This value represents the location at the time of acquisition.

Scale
This is the scaling factor. A factor of 1 will display the image as it was recorded. Selecting a scaling
factor higher than 1 will magnify the image by that factor.
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Age Limit
This is the limit, assigned by the user, the M300 will use to determine if an image should be
indicated as “old”. For example, if a user inputs an age limit of 10, the M300 will continue to work
as normal. However, if the currently displayed HVPS image becomes 10 minutes old relative to the
M300 system buffer during playback, the M300 will then place hash lines across the image to
indicate to the user that it has gone past its age limit.

HVPS ‐ Scaling the Display
1. In the HVPS display window you are scaling, click on the Scale drop down menu.
Select the scaling value needed by either selecting a value from the drop down menu, or typing in the
number directly. For the most part, the user will not need to scale the display above 5x.

HVPS ‐ Changing the Acquisition Address
1. In the HVPS display window you are changing the I/O address, click on the Acquisition Address

drop down menu.
2. Select the address needed by selecting a value from the drop down menu.

HVPS ‐ Adjusting the Age Limit
1. In the HVPS display window you are changing the I/O address, click on the Age Limit text box.
2. Type the value of the age limit desired (in minutes) and hit Enter. At this point the M300 will

display hash lines across any images that are older than this value.
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LIST (LST.300)
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MOVING AIR MASS (MAM.300)

Latitude
The aircraft’s angular distance north or south of the earth’s equator, measured in degrees.

Longitude
The aircraft’s angular distance on the earth's surface, measured east or west from the prime meridian
at Greenwich, England, measured in degrees.

Speed
The rate at which the aircraft is traveling during a moment in time.

Set Position
This button will make the point the aircraft is currently at the point of origin for the plot.

Rings
Changing this value changes the number of reference rings displayed on the graph. With this
example plot, the value is five which is why 5 reference rings are displayed on this graph.

Maximum Limit
The value which restricts the maximum range of the plot.

Heading
The current direction the aircraft is following measured in degrees from the original graph starting
point.

Direction
The aircraft’s angular relationship, measured in degrees, to due north.

Aircraft
The pictorial representation of the aircraft.
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Course
The plotted path of the aircraft.

Reference Rings
Can be controlled by the Rings field and provide a reference for points on the graph.
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PROBE DISTRIBUTION (PDI.300)
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POSITION (POS.300)
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PLAN POSITION INDICATOR (PPI.300)

Intensity in dbz
The amount of energy which is received back at the radar dish is measured in units of DBZ
(decibels). The higher the DBZ value the larger the object i.e. large raindrops and hail produce high
DBZ values. This chart gives a reference of the dbz value to the plot color.

Range
The area in which the graph displays probe data collection.

Noise Level
The amplitude level of the undesired background noise.

Color Scheme
A user definable parameter which allows multiple color schemes to be applied to the plot. During the
setup of the HTI the user must create a file which identifies the name of the scheme as well as the
color parameters. The name of this file is rdr.300 and is located in the project directory. This file can
be edited at any time but in order for the changes to take effect the project must be opened after the
changes have been made.
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SKEWT (SKT.300)

Temp/Dewpt
The current degree of temperature and the temperature at which dew begins to form.

IB/IT/DA/SA/MR Buttons
The buttons control which specialized grid lines will be displayed on the graph..
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STRIP CHART (STP.300)

View Slider
Controls the width of the data display area.
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TEXT (TXT.300)

Absolute/Offset Position Toggle
Toggles between absolute and offset mode to be used when using the X/Y Values text box (see
below). 

X/Y Values
View X and Y values for text boxes or set the X and Y values for the text boxes if the Lock Change
Option is unlocked.

On Click Selection
Each text box is individual and when a text box is selected it is highlighted as illustrated above. This
will allow the user to manipulate the position of the data via the mouse, the X/Y values, or the
keyboard arrows. Note that multiple entries can be selected at any given time.

Text ‐ Balloon for Text Entries
If you stop the mouse over a data or table entry, a balloon popup with the name and formula number
for the text entry. This allows the user to find out which formula number is assigned to a particular
text entry. If the Balloon color has yellow background the formula is in it’s normal computational
state. If the Balloon color has a red background then the formula is being overridden.

Text ‐ Delete Text Entries
To delete text entries, first select the entries (see how to select the entries in the next paragraph).
Then just hit the ‘delete’ key.
Use extreme caution when doing this. The entries will be deleted without warning. Also there is no
way to undo this.
If you decided that the delete was a bad idea, then you can exit the M300. When asked to save the
project, just say no. The next time you start the M300 your entries will be there.
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Text ‐ Moving Text Entries

Note: The lock/unlock button must be set to unlock before making any changes to the text display

1. Click on the text entries you wish to move in any of the following ways (Selected text entries will
be indicated by a highlighting frame around each entry):
a.) Click on the entry you wish to move with the mouse.
b.) To select multiple entries, hold down the Ctrl key while selecting each entry with the mouse 

button.
c.) Hold down the mouse button (while not over any entries) and drag the highlighting box until 

all entries you wish to select are within the box. Once the mouse button is released, all text 
entries within the box will be selected.

d.) To select all of the entries at the same time use Ctrl+A. 
2. Move the selected text entries in any of the following ways:

a.) Place the mouse pointer over any of the selected text and drag the entries to where you need 
them.

b.) Using the arrow keys on the keyboard, depress the arrow key in the direction you would like 
to move them. Hold down the key to repeat.

c.) In the X/Y text fields at the top of the window, insert the value into the appropriate field. If 
offset is selected (indicated by a plus symbol on the button), any values entered into the X/Y 
Values text box will force selected text to move by the amount indicated. If absolute is selected 
(indicated by a square on the button) any values entered will be relative to the (0,0) point 
(upper left corner of the window) (see “Absolute/Offset Position Toggle”  on page 199).

Text ‐ Align Text Entries
You can align text entries either horizontally or vertically.
To do this, first select the desired entries. Then use one of the following key combinations to perform
the desired align operation.
Ctrl+L - align on the left side.
Ctrl+R - align on the right side.
Ctrl+C - perform a center align.
Ctrl+T - align on the top.
Ctrl+B - align on the bottom.
Ctrl+M - perform a middle align.

Text ‐ Change formula value for Text Entry
A quick way to change the text entry name or the value of the formula, can be accomplished by first
selecting a single entry and then click on the ‘insert’ key.
This will bring up a quick change dialog window. The user can enter the desired value and click on
the close button to get ride of the dialog.
DATA DISPLAYS200



M300 USERS GUIDE  SEA
Text ‐ Creating a New Text Entry

Note: The lock/unlock button must be set to unlock before making any changes to the text display. Also,
there must already be at least one text entry present in the text display when the M300 starts, before
creating and/or modifying entries. If this is a new text window, you must create the first entry by manually
editing the txt.300 file in the project directory (See M300 Reference for more information regarding the
txt.300 file and it’s format).

1. Right click anywhere a text entry does not exist. This will display a text entry dialog like the one
shown below.

Name
Name of the label, formula or table.

Formula Number/Name
Used to identify the formula associated with the text entry. A user may reference a formula by using
either the formula number (without the F prefix) or the exact string associated with it in the formula
table.

Format
The format specifier used to cast the formula results into a specific form. For more information on
format specifiers, see “Format Syntax”  on page 202

Rows/Columns
These fields are used in conjunction with a text entry that contains multiple results. For instance, if a
formula result has 20 values in it’s array, then the user could make a 5 rows by 4 columns text entry
to display all 20 results in a tabular form.

Font Button
Opens up a font dialog allowing the user to change the font type, size and attributes (i.e. bold, italic,
etc.).

Color Button
Opens up a color dialog allowing the user to change the color of the text entry.

Next/Prev Buttons
Click on the Next or Previous buttons to cycle to the next or previous text entry list, respectively. If
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this is only one text entry, these buttons will have no effect.

Done Button
Click on this button to finalize the changes you have made and close the dialog.

Note: There are 3 different kinds of text entries allowed. A text label (type 1) is just a text string with no
association to the formula table, it merely displays whatever ‘Name’ it is given. A formula text entry (type 2)
displays whatever results was calculated according to it’s definition in the formula table. A table entry (type
3) is the same as a formula entry with the exception that it displays values in a tabular form (n‐rows by m‐
columns). Depending on what type of text entry you are creating/modifying, certain fields are required and
other fields are optional. See the table below for more information. Note that each higher type requires all
the fields of the lower type. For example, the Table type require all the fields required by the Formula and
Label types as well. Note that the text entry is not created until a text entry is given a name in the ‘Name’
field. 

2. Enter a name for the new text entry in the ‘Name’ field. If you are creating a label type, this is all
that is required; therefore, skip to step 5.

3. Enter the formula number/name (must be the same as that stored in the formula table) in the
‘Formula Number/Name’ field. If you are creating a formula type, this is all that is required;
therefore, skip to step 5.

4. Enter the number of rows and columns you need in the ‘Rows’ and ‘Columns’ fields respectively.
There are few caveats the user must be aware of regarding the use of the table type text entry.
a.) When rows and columns are entered, they must both be greater than zero.
b.) Array values from the associated formula are filled into the table from column to row. That is, 

the first column is filled with values all the way to whatever value is given for rows OR the 
maximum number of values in the array, whichever comes first.

c.) The minimum of the number of values in the array vs. the number of (rows*columns) will be 
displayed.

5. If you need to format the output of your formula, you may enter it into the ‘Format’ field. For
example if you need to format a floating-point result to have 8 significant digits 2 of those in the
decimal positions, enter %6.2f. The table below provides a general guide for using this field. 

Text Entry Required Fields Type

Label ‘Name’ 1

Formula Formula Name/Number 2

Table Formula, Name/Number, Rows, Columns 3

Required Fields  For  a  Text  Entry

Syntax Description Formula/Result Conversion Result

%s String S[5] %s Hello

Format  Syntax
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Note: Use of the string format modifier for any other data types other than string types may result in
undefined behavior.

6. To change the font (default is Helvetica) of the text entry, click on the font button. This will
bring up a font selection dialog. When finished click on Done. 

7. To change the color of the text entry, click on the color button. This will display the color dialog
(see “Changing a display color”  on page 174). 

8. To finish creating the text entry, click on Done.

Text ‐ Modifying an Existing Text Entry

Note: The lock/unlock button must be set to unlock before making any changes to the text display. 

1. Right click on the text entry you wish to modify. This will display the text entry edit dialog.
2. Change the text entry fields as necessary. It is assumed you are familiar with the text entries and

which fields are used for each text entry type. If you need more specific information on this
subject, see “Text - Creating a New Text Entry”  on page 201.

%d Decimal (base 10) I[1]/100 %05d 00100

%X Hexadecimal (base 16) I[1]/254 %02X FE

%f Float (single precision) F[1]/120.322 %3.2f 120.32

%g Float (double precision) D[1]/210.119191 %3.5g 210.11919

Syntax Description Formula/Result Conversion Result

Format  Syntax
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X VS. Y 

View Slider
Controls the width of the data display area.
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SERVICE AND TROUBLESHOOTING

Although unlikely, there may be occasions when the M300 or the underlying QNX system
experiences problems functioning and/or booting. The following troubleshooting procedures are
meant to guide the user through the most likely causes of common problems such as hard disk
failures, communication problems, boot failures, etc.

KNOWN PROBLEMS

The following is a list of currently known problems or issues with the M300 software. 

1. Applications that use a large amount of memory can have a negative effect on the proxy duration
time when they exit. It is therefore recommended that the user restrain from using any
applications that might affect the M300 performance during real time acquisition mode.

2. While running M300 in acquisition mode, you might notice, once in a while, a longer value for
proxy duration time when you exit certain applications. Depending on the system frequency and
the load of acquisition events, this might cause a proxy not to be delivered once in a while (under
these circumstances only).

3. If it’s required to run another application when the M300 is running in acquisition mode, it is
recommended that the user minimize the application as opposed to closing it. This will not have
an effect on the M300 performance. When the M300 isn’t running anymore, the user can close
the unused minimized applications.

4. We generate an interrupt based on the system frequency. This interrupt is responsible for running
all the acquisition events. Since we can’t use floating point operations in the interrupt service
routine (ISR) and it is not recommended to do much work in the ISA (for performance reasons)
we fire a proxy (this is the suggested way to do this type of work). We have assigned this proxy the
highest priority possible and the kernel takes care of calling a routine. It is in this routine that we
perform all the acquisition events. So proxy latency and duration time are just as important as the
ISR latency and duration time.

5. SEA Applications that might have an effect on the proxy duration are RawView, ImageView and
SEATool.

6. The seadrive runs at priority 10. This can interfere with the M300. Don’t run seadrive at the
same time as M300.

7. The ‘cp’ (copy) runs at priority 10. This can interfere with the M300. Don’t perform a copy while
M300 is running.
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8. According to QSSL, the developers of QNX, large amounts of memory allocation (done either
statically or dynamically) can have effects on the time it takes to deliver a proxy. Since the kernel
is single threaded, if they are in the kernel doing memory allocation and mappings and an
interrupt goes off which needs to deliver a proxy, then they delay that delivery until after we exit
the kernel (on the way out actually).

9. The ‘Fatfsys’ driver can allow users to create files larger than 2GB on DOS partitions (such as on
USB and the Kingston drives). These files cannot be read back into the QNX 4 system. As a fix,
we have modified M300 to limit the data file size just short of the 2GB limit. Another work
around is to take the file in a Windows machine and resize it to less than 2GB, then recopy the
file to the desired transmission medium (USB, DVD, Kingston, etc.).

BACKUP OR DATA AND PROJECTS

One of the main tasks for the M300 system is to acquire data. The raw M300 binary files are
extremely important. They must be copied as soon as possible to another system or medium.

The more copies of your data files you have (in different physical locations) the better the chances are
of holding on to your data in case of a problem which can cause permanent data loss.

The data files can be transferred via network using FTP, mounted partitions, USB drives, etc.

The data files cannot be burned on to CD or DVD directly in the QNX 4 system. To do this you
must first copy the data to a Windows machine or another system that supports this.

Project files are configuration files used to run the M300 system. These files can also be extremely
valuable. Again it is recommended that the user backup these files to other systems. The files should
be archived using the tar utility and then compressed. The archive of files is necessary to keep the file
permissions.

SERIAL PORT TROUBLESHOOTING

The following general guidelines will help you troubleshoot any problems you may experience with
serial port operations.

1. Make sure the serial cable is connected from the outside to the correct port on the system.
2. Use the ‘serread’ utility (see SEA Utilities Users Guide) to read data in from the instrument

without using the M300 software. This will confirm that the instrument is connected to the
correct serial port. It also ensures that the instrument is turned on, transmitting and that the
correct serial port protocol is being used. For example, if you have 9600 baud data coming in on
‘/dev/ser3’, type serread -b 9600 /dev/ser3 and make sure the data looks correct before
going to the next step.

3. Add a board for serial port data. Make sure you have the correct port and protocol parameters.
4. Add an acquisition event for serial ASCII data, type 37. Make sure the data size is large enough to

handle the largest block. Set Para1 (End of Sentence Character) to 10 (LF) or 13 (CR).
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5. Run the M300 and store the binary data to a file.
6. Using the RawView Utility to check if the ASCII data is being acquired from the M300, specify

the correct tag number in the filter text box, switch to ASCII display mode (‘A’ Button), and click
on the signed/unsigned button (+/-). If the data is there, you can go to the next step, otherwise,
check or change Para1, and/or the acquisition type.

7. Now that you have verified data coming into the system, add this formula to the fml.300 table:
“SerialData” “” F2000 S[300] A2000 assuming that tag number is 2000, with less than
300 characters for the data size.

8. Ensure you have the correct trigger before the formula to get the serial data. If the data is in the
sync buffer, use a sync trigger, otherwise use the appropriate trigger. For example, Trigger =
“SerialASCII” 20 tracpak “Never” Never None

9. Check the formula for the data in a Formula Watch and Alter Window. If the data is there, then
you can add more formulas and displays. If the data is not there, then check the trigger to make
sure you have the correct settings.

HARD DRIVE TROUBLESHOOTING

If there is hard drive problem, the following steps will verify the drive integrity by checking for bad
blocks and ensuring the file system integrity or restoring it if compromised in some way. These two
steps can eliminate a host of minor problems and malfunctions.

Note: Some of the following steps can be very time consuming. Ensure that you do not need to use the hard
drive for at least 24 hours before running these steps. The user should also ensure that there is a reliable
supply of power. It is therefore recommended that these tests be done using ground power rather than
aircraft or other power sources.

1. Check the integrity of the QNX file system by using the following, as root: chkfsys -u / This
should be done at least once per week or after an improper shutdown. 

2. To check the entire drive for bad blocks, type dcheck -m -r -V -e /dev/diskName at the
command prompt, where ‘diskName’ is the drive that is to be checked. For example, to check the
main hard drive you would use dcheck -m -r -V -e /dev/hd0 This can be done if you are
suspecting a problem with bad blocks on the hard drive (which is very rare).

SERVICE

If everything is working okay and your system is fairly new, then there is little maintenance required.
Depending on the type of system, there are different aspects to consider for maintenance issues.

If your system is experiencing problems crashing, contact SEA. Our systems are designed to run
without issues. An occasional crash might be expected. However repeated problems are a symptom
that can be traced and solved.

After shipping the system it's recommend to take the lid off and inspect the inside of the system to
make sure the interface cards are properly secured.
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On rack mount systems you want to make sure the cards are fully inserted on the PCI/ISA slots.

The card guides should be installed and make sure that all hold downs for the cards are pushing
down on the cards to prevent the cards from coming loose.

On older systems, hard drives, CPU boards, power supply and passive backplanes should be replaced
with new ones.

Doing software upgrades to the M300 system ensure you have the latest fixes.

Software upgrades to the QNX 4/Photon/TCP/IP drivers. SATA driver and USB 2.0 drivers for
QNX 4 are much faster than the previous versions for EIDE. This is great news for real time data
storage to the files and also to copy to USB drives.

Malfunctioning interface cards should be tested and sent to SEA for repair.

The interface cards in the M300 system will get hardware and firmware upgrades over time.

REPORTING A PROBLEM

When reporting a problem with the M300 software we may ask you to send in a data file which
shows the problem. We can normally use the M300 in playback mode to look at the data and check
the problem.

In addition to a data file we might also ask for the project files. This way we should be able to
recreate your problem and develop a solution. To contact SEA support, (See “Contacting SEA”  in
on page 15).

We use the Logger utility to be a collecting point for all warning/error messages for the utilities.

The M300Logger is used to collect warning/error messages for the M300.

These utilities have the capability to capture and store the messages to a log file (*.log). This file
might be very useful as well when reporting a problem.

At the very minimum a capture of the Logger or M300Logger window might be needed to see the
error message. Assuming the message has not scrolled off screen.
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